Magellan Explorer 3

Printed manual

Copyright © 2005 Enriva Development DA
# Table of Contents

## Foreword

### Part I Introduction

1. Help on Help ................................................................. 6
2. Requirements ...................................................................... 7
3. New in version 3.0 ............................................................ 7
4. New in version 3.10 .......................................................... 9
5. New in version 3.20 .......................................................... 10
6. New in version 3.30 .......................................................... 12
7. New in version 3.31 .......................................................... 13
8. Acknowledgements ......................................................... 14
9. Beta testers ....................................................................... 14

## Part II Getting Started

1. Selecting files and folders .................................................. 19
2. Using the built in tools ...................................................... 20
3. Working with archives ..................................................... 23
4. Organizing favorites ....................................................... 25
5. Customizing folders ....................................................... 25
6. Using context menus ...................................................... 26

## Part III Step by Step Guides

1. Adding tools to the main toolbar ........................................ 29
2. Modifying the quick/navigation Bar .................................... 29
3. Modifying the tools menu ................................................ 30
4. Modifying a keyboard shortcut ......................................... 30
5. Connecting to an FTP site ............................................... 30

## Part IV Reference

1. Default keyboard shortcuts .............................................. 34
2. Command line options ................................................... 34
3. Glossary .......................................................................... 35
4. Windows .......................................................................... 37
   - Progress Window .......................................................... 37
   - Viewer Window ............................................................ 38
   - FTP Information Window ............................................. 40
5. Menu bar .......................................................................... 40
   - File .............................................................................. 41
   - View ............................................................................ 41
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Favorites</td>
<td>43</td>
</tr>
<tr>
<td>FTP</td>
<td>43</td>
</tr>
<tr>
<td>Archive</td>
<td>44</td>
</tr>
<tr>
<td>Tools</td>
<td>45</td>
</tr>
<tr>
<td>Options</td>
<td>46</td>
</tr>
<tr>
<td>Window</td>
<td>47</td>
</tr>
<tr>
<td>Help</td>
<td>48</td>
</tr>
<tr>
<td><strong>6 Toolbars</strong></td>
<td>48</td>
</tr>
<tr>
<td>The main toolbar</td>
<td>48</td>
</tr>
<tr>
<td>The drive bar</td>
<td>49</td>
</tr>
<tr>
<td>The navigation bar</td>
<td>49</td>
</tr>
<tr>
<td>The quick bar</td>
<td>50</td>
</tr>
<tr>
<td><strong>7 Tools</strong></td>
<td>50</td>
</tr>
<tr>
<td>Basic tools</td>
<td>50</td>
</tr>
<tr>
<td>File selection</td>
<td>50</td>
</tr>
<tr>
<td>Folder navigation</td>
<td>52</td>
</tr>
<tr>
<td>Copying and moving files</td>
<td>53</td>
</tr>
<tr>
<td>Deleting files</td>
<td>55</td>
</tr>
<tr>
<td>Renaming files</td>
<td>55</td>
</tr>
<tr>
<td>Modifying attributes</td>
<td>58</td>
</tr>
<tr>
<td>Other operations</td>
<td>61</td>
</tr>
<tr>
<td><strong>File manipulation</strong></td>
<td>63</td>
</tr>
<tr>
<td>View and edit</td>
<td>63</td>
</tr>
<tr>
<td>Encoding and decoding</td>
<td>64</td>
</tr>
<tr>
<td>Splitting and joining</td>
<td>66</td>
</tr>
<tr>
<td><strong>Advanced tools</strong></td>
<td>68</td>
</tr>
<tr>
<td>Search and filter</td>
<td>68</td>
</tr>
<tr>
<td>Folder Compare and Synchronize</td>
<td>72</td>
</tr>
<tr>
<td>Virtual Folder</td>
<td>74</td>
</tr>
<tr>
<td>Print Folder</td>
<td>75</td>
</tr>
<tr>
<td>FTP tools</td>
<td>77</td>
</tr>
<tr>
<td><strong>8 Preferences</strong></td>
<td>79</td>
</tr>
<tr>
<td>User Interface</td>
<td>80</td>
</tr>
<tr>
<td>Defaults</td>
<td>80</td>
</tr>
<tr>
<td>Colors and fonts</td>
<td>81</td>
</tr>
<tr>
<td>Display</td>
<td>82</td>
</tr>
<tr>
<td>Keyboard</td>
<td>82</td>
</tr>
<tr>
<td>Confirmations</td>
<td>83</td>
</tr>
<tr>
<td>Selection</td>
<td>83</td>
</tr>
<tr>
<td>Advanced selection</td>
<td>85</td>
</tr>
<tr>
<td><strong>Folder Windows</strong></td>
<td>86</td>
</tr>
<tr>
<td>General</td>
<td>86</td>
</tr>
<tr>
<td>Startup</td>
<td>87</td>
</tr>
<tr>
<td>Advanced</td>
<td>87</td>
</tr>
<tr>
<td>Customized folders</td>
<td>89</td>
</tr>
<tr>
<td><strong>Tools and toolbars</strong></td>
<td>89</td>
</tr>
<tr>
<td>Main toolbar</td>
<td>89</td>
</tr>
<tr>
<td>Navigation bar</td>
<td>92</td>
</tr>
<tr>
<td>Quick bar</td>
<td>93</td>
</tr>
<tr>
<td>Drive bar</td>
<td>93</td>
</tr>
<tr>
<td>Tools menu</td>
<td>94</td>
</tr>
<tr>
<td>Custom tools</td>
<td>94</td>
</tr>
<tr>
<td>External editors</td>
<td>97</td>
</tr>
</tbody>
</table>
Part V  Order Information  

1 Upgrade from a previous version ................................................................. 115
2 Bonus features ................................................................................................... 115
3 Online Ordering .................................................................................................. 116
4 Phone/Fax ........................................................................................................... 116
5 Cash .................................................................................................................... 116
6 Money Orders / Checks ................................................................................. 117
7 International resellers ...................................................................................... 118

   Australia ........................................................................................................ 118
   Belgium ......................................................................................................... 119
   Denmark ....................................................................................................... 120
   Finland ......................................................................................................... 120
   France .......................................................................................................... 121
   Germany ........................................................................................................ 121
   Italy ............................................................................................................... 122
   The Netherlands ........................................................................................... 122
   Norway ......................................................................................................... 123
   Sweden ........................................................................................................ 124
   United Kingdom ............................................................................................ 124
   United States ............................................................................................... 125

8 Order forms ...................................................................................................... 125
   Order form - Aquarian .................................................................................. 125
   Order form - BT Software ............................................................................. 126
   Order form - BMT Micro .............................................................................. 127

Part VI  Support  .................................................................................................. 129
Part I
Introduction

What is Magellan Explorer™?
Magellan Explorer is a Windows file, archive and FTP management utility.

It has a familiar, dual window interface that makes copying and comparing files a breeze. The integrated FTP and archive clients means that internet sites and compressed archives, such as Zip files, can be opened if as they were normal folders. Move seamlessly between them using Bookmarks, History and Back/Forwards buttons just like in your web browser.

The built-in tool chest gives you the ability to display the size of highlighted folders, find files, synchronize folders, time stamp files and much more with a single click.

It is possible to configure almost every aspect of Magellan Explorer, from how you select files down to the color of individual buttons.

Version 3 - The third incarnation
If you have used previous versions of Magellan Explorer before, you will find version 3 to be better in almost every aspect. This new version contains more features, more options and improved performance and ease of use. Please see New in version 3.0.

More information about upgrading to Magellan Explorer 3 can be found here.

The Help system
In most cases you can press F1 to get help with what you are currently working on. If no specific help can be located then the introduction page will be displayed.

To learn more about how the help system is organized please read the Help on Help section.

1.1 Help on Help
This short text will explain the layout of the help system.

If there is anything you can't figure out, or you suspect a bug/error in Magellan Explorer don't hesitate to contact us. You will find the numbers and addresses on the Customer Support page.

Getting Started
It is recommended that new users who are not familiar with the way Magellan Explorer works read through this section. In particular the topic Working with Magellan Explorer, as it explains how you perform all the basic operations.

Step by Step Guides
Contains walk-through guides for the novice user to some of Magellan Explorer's features.

Reference
Divided into elements, this section describes every part of Magellan Explorer. It also contains a list of the default keyboard shortcuts.
Order Information
If you have downloaded the program from the Internet or copied it from a CD-ROM it is most likely just an evaluation version and it will expire after 30 days of use. Read more about this on the Order Overview page.

The section also contains extensive information on how and where you can purchase your copy of Magellan Explorer.

Glossary
Explanations of the terms used in the help file. These are linked into the text wherever they are used.

Support
If you are in need of support you will find all the relevant addresses here. Additionally it contains the license agreement and contact information.

1.2 Requirements

Minimum system requirements
- Internet Explorer 4 or greater
- Intel Pentium or AMD Athlon cpu
- 64MB RAM

* Additional updates may be required for Windows 98 or Windows NT 4.0.

Recommended system
- Windows XP or Windows Server 2003
- Internet Explorer 6
- Intel Pentium 4 or AMD Athlon XP/64
- 256MB RAM

1.3 New in version 3.0

The new version of Magellan Explorer has been rewritten from the ground and is filled to the brim with new features, enhancements and new options to make you file management easier than ever before.

Improved toolbars
Magellan Explorer is more flexible than ever before to fit your needs exactly.

- Place any tool on any toolbar
- Organize the tools menu
- Place your favorite folders on your toolbars for easy access

More flexible folder views
You can now use all the views available in Windows Explorer to their full potential while retaining full
access to the powerful Magellan Explorer view. This gives you full access to image and video thumbnails, custom font folders, etc.

Using the new customize folder feature you can even save the default view and layout for individual folders or folder trees.

**Enhanced explorer mode**

A dual windows explorer style window layout is now available where each folder window has both a tree view and a list view. Arrange them either side by side or on top of each other.

**Improved search & filter**

The new search and filter options have been completely redesigned in order to make them both easier and more powerful to use. Find files quickly by name or content with the basic view or use the advanced options to filter by dates and sizes.

You can even use regular expressions to express even more advanced file name and content searches.

The new filter box below the folder windows enables instant as-you-type filtering on filenames as well as easy selection of previously stored filters.

**Improved archive management**

Magellan Explorer takes ZIP management to the next level with the new fast and stable ZIP engine. Use the new industry standard Deflate64™ and Burrows Wheeler algorithms to achieve even better compression.

Support for managing UNIX style archives is now handled with support for the following formats.

- GZip
- Z (Compress)
- BZip2
- TAR (optionally combined with one of the above)

The ACE and RAR archiver support has also been enhanced to fully support the latest versions of these archives.

**Brand new FTP engine**

A fully featured site manager is now available to let you easily organize your favorite sites. Favorite folders link seamlessly with sites in the site manager making it easy to create and manage your FTP site list.

The new FTP engine provides a new level of stability, ensuring your FTP transfers run smoothly. New features are also available such as preserving modified time & date on transferred files (compatible servers only) and improved search and filter integration.

**Enhanced image viewer**

The enhanced image viewer contains the following new features

- Full GIF format support
- Ability to zoom and rotate images
- Automatically fits image to screen
- Slide show support for easy viewing of multiple files

**Additional tools available**

Magellan Explorer can now Split & Join files. Ideal for transferring large files on small media.

The new Encode and Decode features allow encoding and decoding of the following formats.

- UUEncode
- XXEncode
- Base64
- BinHex
- Quoted-Printable
- Hex

The Synchronize Folder tool has been upgraded to perform full synchronization of folders.

**Enhanced tools**

The Print Folder tool has been upgraded with more features such as MD5 checksums, folder sizes, and a lot of other options to make it even more useful. The new slick user interface makes it easier to use than ever before.

The Group Rename tool now supports 9 different renaming modes. They include wildcard patterns, regular expressions, case transformation and more.

Virtual Folders can now be saved between sessions, making them an invaluable means of keeping track of your files.

**Other new features and enhancements**

- Calculate MD5 checksums for files
- Effortlessly view text or binary files of up to 2GB
- Path box auto completion and drives drop down
- Dynamic Quick bar based on folder window content
- Option to start automatically with Windows

Deflate64™ is a trademark of PKWARE Inc.

### 1.4 New in version 3.10

The changes and additions since version 3.0 are as follows.

**Additions**

- Option (Misc|Misc) to disable trimming of working set on minimize
- Option (Folders|Advanced) to disable automatic use of shell view (e.g. Desktop)
- Added additional payment options including PayPal
- Option (Tools and Toolbars|Toolbar|Appearance) to disable XP themes on main toolbar
- Added a do-not-show-again dialog after a customizing folder

**Changes**
• Do not check for updates more than once every 24 hours
• FilterBox now defaults to include sub folders (Misc|Search and Filter)
• Right clicking on an empty area of the drive bar now displays the standard toolbar menu

Fixes

• Going from main toolbar in the middle to no toolbar would fail to properly hide the toolbar
• Double clicking files inside virtual folders with non-default columns display no longer crashes
• Navigating to the parent folder from a virtual folder using the Parent tool now works
• Navigating to the root folder from a virtual folder now opens My Computer instead of displaying an error
• Fixed problems with re-creating a virtual folder with the same name
• Added support for "Open With" menu in Dutch versions of Windows
• Do not give weird error when trying to get an MD5 sum of a folder
• Show extraction context menu items for .tgz files also
• Fixed issues with ejecting removable media that have been opened in Magellan Explorer
• Fixed broken drag&drop of favorites
• Attribute dialog now correctly allows selection of file time in addition to date
• Fixed "Open in Magellan Explorer" context menu item
• Selecting "My Computer" from label box context menu now takes you there and not to the Desktop
• Split now uses correct size of 1.44MB floppy
• Auto size of viewer window now takes menubar into account
• New|Shortcut from folder window context menu now creates link in correct folder
• Fixed startup issues on Windows NT 4.0
• Changing folder during automatic folder refresh could lead to crash or incorrectly displayed folder view
• The custom tools %tp argument now works correctly (instead of reporting an incorrect error)
• Minimize on startup will now correctly maximize the window on restore if window state was saved as maximized
• Fixed an issue with the pathbox losing focus whenever Magellan auto refreshed a folder
• Do not copy empty descriptions when copying files. Preserve the existing, if any, instead
• Toolbar is no longer placed 50% outside window with placement in middle and a single folder windows
• User tools %FN and %FF tokens now yield the correct paths

1.5 New in version 3.20

The changes and additions since version 3.10 are as follows.

Additions

• Enabled folder customize on My Computer folder also
• Added auto save of folder layout, can be disabled in Folder Window prefs. Explicitly saved folders override it of course.
• Tip of the Day at startup
• Connect status dialog to make it more clear what's happening during connect as well as make it easier to abort connects. A 'Retry now' button is also available to retry immediately rather than waiting.
• Added option to display filename extension in Ext column instead of in Name column. Configurable from the general tab in folder window preferences.

Changes
• Option to auto start with windows is now saved in current user instead of local machine registry
• Updated help with description of the dynamic Quick Bar feature
• Preserve directory timestamps when copying (WinNT/2000/XP/2003 only)
• Hotkeys can now be assigned to the ALT key also
• Changed default drag&drop behavior to match Windows Explorer. Default is move within same drive, copy when dragging to a different drive. The option is configurable, and the previous two options (copy or move) remain.
• By popular request the favorites are back in My Computer (option to turn off in Misc|Misc prefs)
• Label box now displays "(filtered)" after volume label when folder contents are filtered
• Updated FAQ section in the manual with all the FAQ entries from the web site
• Update drivebar asynchronously when activating window. Speeds up window activation to "normal" speeds.
• Automatically remember divider position on exit (instead of manually through the option on the options menu)

Fixes

• Fixed a rare bug that could cause crashes while navigating folders, especially with non-default cache settings
• Right click on main toolbar buttons with toolbar at top of window fixed
• Show correct titlebar text on startup (<folder> - Magellan Explorer)
• Show application in Windows task manager on applications tab
• Correctly save changes when configuring multiple editors in one go on the External editors config page
• Correctly fill Send To and Open With menus on German Windows
• Fixed an issue with Describe and windows style listview where files would appear selected although they were not
• Fixed importing of 2.x FTP favorites that weren't prefixed by "ftp://"
• Fixed a warning message when trying to assign a hotkey that was already assigned to another tool
• Correctly update title bar and status bar when toggling active folder window with the keyboard (TAB or space)
• Fixed preservation of file description when renaming a file with "one click rename" (and not the rename tool)
• When copying empty folders from an FTP site make sure they're created locally
• Fixed an FTP bug in the folder delete code causing inability to delete folders on the root of the drive
• Correctly parse description files containing lines with only whitespace
• Disallow folder synchronize to/from an archive. It's not supported and would cause a crash
• Report correct file size for >4GB files compressed inside ZIP archives
• Fixed a bug that could cause only 2 FTP connections to be available in the full version also
• Fixed a bug that would disallow copying e.g. c:\foo into c:\foobar.
• Fixed a bug that could cause filtered folder contents to be cached and displayed when the filter was removed
• Plugged a small memory leak causing file descriptor leakage when doubleclicking e.g. gzip archives
• Fixed an FTP bug where a new connection would be opened after changing permission of files (by chmod)
• Much improved FTP connect with separate lookup/connect. Should also work much better on Windows 98/ME now.
• Fixed alignment of 'time remaining' and 'transfer speed' text in progress dialog
• Fixed a selection issue with explorer style listview and SHIFT+PgDd/PgUp where Magellan would believe nothing was selected, even though the listview showed a selection.
• Fixed context menu for files on Desktop in Magellan Details view
• Fixed timestamp of folder (WinNT/2000/XP2003 only) from attribute tool
• Fixed crashes occurring when trying to perform file operations, e.g. rename, on archives directly in tree pane
• Fixed keyboard shortcuts for Archive and FTP menu
• Fixed issues with splitters/dividers moving somewhat for each restart of Magellan

1.6 New in version 3.30

The changes since version 3.20 are as follows.

Additions

• Show a configuration wizard at first run, allowing choice of selection style and window layout

Changes

• Do not open ZIP archives with extension other than .zip automatically when double clicked, unless configured to do so from the ZIP archiver preferences. Makes it easier to deal with file formats that are really ZIP archives, but are associated with other programs
• Double buffered windows list control for less flicker
• Quicker update of ZIP archive contents when creating folders inside it
• Changed layout of Options menu to make navigation easier
• Allow multiple copies of Magellan running in the trial version and enable all image viewing features also
• Show a configuration wizard at first run, allowing choice of selection style and window layout
• Correctly say "Move" and not "Copy" in dialog prompting for new name in "Move as" operation
• Allow drag&drop onto "." entry in folders to drag to parent folder
• Icons and List views are now native explorer style list views rather than shell list views and can now be filtered etc.
• Display full path in image viewer title bar (if main window title bar configured to do so)
• Re-order text on image viewer title bar, place filename and details first (like Magellan main window title bar)

Fixes

• Fixed a rare case where (in Windows Explorer list view mode only) the selection displayed would not be correct after a folder was automatically refreshed on activating the Magellan window
• Make auto size using CTRL+A in image viewer work
• Fixed a bug that would display a harmless, yet annoying, "The specified path was not found" dialog after moving a folder within the same drive on Windows 9x. NT/2000/XP was not affected.
• Display correct icon next to archives with upper case extensions that do not have an associated Windows file type, but are still handled by Magellan
• Fixed saving of column width in Windows Explorer list view mode for folder layouts
• Correctly say "Move" and not "Copy" in dialog prompting for new name in "Move as" operation
• Do not load icons from within executables from network drives by default. Option in folder prefs to enable.
• Fixed a crash occurring when editing a file within an archive. Would also occur immediately for e.g. Office files
• Fixed issues with re-ordering columns and popup menu working in mysterious ways
• Do not apply automatically saved layout to My Computer folder, it's not compatible and may fix the reported crashes
• Fixed a crash that could occur trying to open an invalid archive from the tree view
• Correctly fill Send To menu on French Windows
• Fixed redraw issue on Windows XP with Classic theme when maximizing the Magellan window
• Improved error handling in file copy code used on Windows NT/2000/XP.
• Fixes a case where the target file could be silently truncated at the position a read error (e.g. CRC error) on the source file occurred at.
• Correctly reset scroll bar positions in image viewer window when sideshow browsing to the next file
• Show 0 byte files as 0kB, not 1kB if configured to display file sizes as kB
• Undo (ctrl+z) in location drop down in the Search tool now works as you would expect
• Fixed a bug that would cause the Browse button on the User tools setup to fail if the directory did not exist
• CTRL+C/CTRL+V copy/paste from virtual folders now work correctly
• Correctly maintain parent folder history when opening favorites directly from My Computer list
• Fixed the "deselect files after file operation" option for Copy operations. Would previously always deselect.
• Fixed "Include hidden files and folders" filter box preferences option. Would previously always show.

1.7 New in version 3.31

The changes since version 3.30 are as follows.

Additions

• The 'New Folder' tool now supports creating multiple folder levels in one go. Just specify "folder1\folder2" etc.
• Added option to Folder Windows\Startup preferences to allow remembering network drives as last open folder

Changes

• Always issue FTP chdir command with trailing slash
• The "backspace" hotkey now navigates to parent folder (like documentation says), not back in ther history

Fixes

• The Archive and FTP menus now work correctly in Windows NT 4.0 also
• Fixed the incorrect fonts used in dialogs in Windows NT 4.0
• Fixed an issue where the Archive menu would appear empty
• Correctly save the "Display special folders...using shell view" option in the Advanced Folder preferences
• Fixed issues with FTP asking to reconnect when not needed in Explorer layout
• Custom tool token %FN now correctly joins paths in the root folder also. Would previously add an extra "$" causing problems on Windows 98/ME
• Custom tool tokens %sp and %tp now always terminates path in a single "\", just like in Magellan Explorer 2.x
• Custom tool token %rd now correctly makes the dialog application modal
• Make all folder browse dialogs application modal
• Fixed a bug that in very rare cases could cause copy from a network drive to fail with the error "Reached the end of the file."
• More aggressive updating of free disk space in label boxes and status line
• Report correct copy speed and time remaining when resuming copy of local files
Correctly reset scroll bar sizes in viewer window when slideshow browsing to the next file
Fixed some FTP proxy issues (would use proxy even if de-selected in quick connect dialog)
FTP Quick Connect now correctly remembers whether a site was anonymous or not
Fixed the "disappearing menu bar" problem. Should now stay visible.

1.8 Acknowledgements

UnRAR
All copyrights to UnRAR.dll are exclusively owned by the author Eugene Roshal.

UnACE
UnAceV2.dll is Copyright © 2000-2002 ACE Compression Software. All Rights Reserved.

UnLHA
The LHA library, unpack.dll, was written by Mart Heubels and Christian Ghisler. Used with permission.

MD5
Magellan Explorer contains RSA Data Security, Inc. MD5 Message-Digest code.

UnARJ

CAB
Magellan Explorer incorporates CAB compression code from the Microsoft Cabinet Software Development Kit. All copyrights for these libraries are exclusively owned by Microsoft Corporation.

PCRE
Regular expression support is provided by the PCRE library package, which is open source software, written by Philip Hazel, and copyright by the University of Cambridge, England. You can download the complete source code from ftp://ftp.csx.cam.ac.uk/pub/software/programming/pcre/.

Microsoft, MS, and MS-DOS are registered trademarks, and Windows, Windows NT are trademarks of Microsoft Corporation in the USA and other countries.

Deflate64™ is a trademark of PKWARE Inc.

Some of the images used on the web site and in the applications are copyright http://www.arttoday.com.

1.9 Beta testers

A special thanks goes out to the Magellan Explorer 3 beta testers. Without your efforts in locating and reproducing bugs Magellan Explorer would not be what it is today. Thanks!
<table>
<thead>
<tr>
<th>Name</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stefan &quot;Zingo&quot; Andersen</td>
<td>Lund, Sweden</td>
</tr>
<tr>
<td>Patrick Cockrell</td>
<td>Austin, Texas, USA</td>
</tr>
<tr>
<td>Giuseppe Criaco</td>
<td>Naples, Italy</td>
</tr>
<tr>
<td>Nate Daken</td>
<td>Millington, New Jersey, USA</td>
</tr>
<tr>
<td>Eric Fraser</td>
<td>Awaba, NSW, Australia</td>
</tr>
<tr>
<td>Troels Walsted Hansen</td>
<td>Tromsø, Norway</td>
</tr>
<tr>
<td>Stein Arild Jakobsen</td>
<td>Tromsø, Norway</td>
</tr>
<tr>
<td>Carol L. Miller</td>
<td>Enid, Oklahoma, USA</td>
</tr>
<tr>
<td>Scott J. Morrison</td>
<td>Livingston, Scotland, UK</td>
</tr>
<tr>
<td>Wallace L. Ottersbach</td>
<td>Houston, Texas, USA</td>
</tr>
<tr>
<td>Sveinar Rasmussen</td>
<td>Lillestrøm, Norway</td>
</tr>
<tr>
<td>Ingve Rosseland</td>
<td>Sandnes, Norway</td>
</tr>
<tr>
<td>Markus Schiegl</td>
<td>Stuttgart, Germany</td>
</tr>
<tr>
<td>Monty Scroggins</td>
<td>Dallas, Texas, USA</td>
</tr>
<tr>
<td>Rob Semenoff</td>
<td>Saskatoon, Canada</td>
</tr>
<tr>
<td>Hans Henrik Wilkens</td>
<td>Oslo, Norway</td>
</tr>
</tbody>
</table>
2 Getting Started

The getting started section contains explanations to how Magellan Explorer works. Below is a breakdown of the main Magellan Explorer window to help familiarize you with the different screen elements.

The navigation bar

The navigation bar is situated below the main menu on the left hand side. It offers easy web browser like navigation buttons such as back and forward buttons with drop down history menus as well as a global history, stop and refresh buttons and the my computer button. The entire contents of the bar as well as its appearance can be configured in the preferences and the position can be changed by dragging the bar.

The drive bar

The drive bar is situated to the right of the navigation bar and provides quick access to all your local and network drives. You can configure which drives should be shown as well as its appearance in the preferences. The position can also be changed by dragging the bar.

The folder window

The folder window displays the files and folders within a local or network folder, an archive or an FTP site. By default two folder windows are shown. You can choose to also display a tree view to the left of the folder window as well as changing the positions of the windows relative to each other from the
Window menu.

**The label box**

The label boxes are situated above the folder windows and displays the label of the folder window as well as the amount of free disk space, if applicable. The main task of the label box is to indicate which folder window is active (highlighted label box). The active folder window is the source of all file operations and the inactive serves as the destination.

**The quick bar**

The quick bars are situated to the right of the label boxes, one for each folder window. The purpose of the quick bar is to give easy access to a limited amount of tools for the folder window below. Whereas the other toolbars work primarily on the active folder window the quick bar always applies to the folder window below, regardless of which folder window is active.

The contents of the quick bar can be customized completely. Furthermore, the quick bar can optionally adapt to the type of folder displayed below and adjust the displayed items automatically.

**The path box**

The path boxes are displayed below each folder window. They display the currently open folder location as well as allowing input of a new path to change the current folder. Auto completion is supported when entering paths. A drop down list is also available to easily access the local and network folders.

**The filter box**

The filter boxes are situated to the right of the path boxes and can be used to quickly filter the contents of the current folder by filename patterns. This is done by entering the desired pattern. You can also select a pre-configured filter from the drop down list.

**The mirror folder buttons**

These two buttons allow you to load the folder displayed in one folder window into the other folder window. If you for instance have C:\ displayed in the left folder window you can click the right arrow and this folder will now also be displayed in the right folder window.

**The main toolbar**

The main toolbar is displayed at the bottom of the main window just above the status bar. By default a only a small subset of tools consisting of the most frequently used tools are displayed. Other tools are available from the Tools menu. However, the tools displayed on this bar can be configured and the size of the bar, both the number of rows and columns, can be changed.

**The status bar**

The status bar displays status messages as well as the size of the selected files, the amount of free disk space and the current folder name of the active folder window.

**Available sections**

The following sections are available to help you get started with Magellan Explorer as quickly as possible.

- Selecting files and folders
2.1 Selecting files and folders

Magellan Explorer boosts a wide range of selection methods in order to suit everyone. Most notably, the default selection scheme used differs from the way you select files and folders in most other Windows applications such as e.g. Windows Explorer. While you can configure Magellan Explorer to work just like other Windows applications, please read through the explanations below first to get a better understanding of the alternative selection methods and their powers. This section will also explain how the different selection methods affect drag & drop in Magellan Explorer.

The active selection method can be changed at any time from the Selection page in the User Interface preferences.

Magellan Explorer selection (Normal selection)

This is the default, and most powerful, selection method in Magellan Explorer. Files are selected/de-selected with the left mouse button by clicking on the them. However, unlike in Windows Explorer, you can select multiple files by simply holding down the left mouse button and dragging the mouse cursor over the files. It's similar to using a paint program and drawing lines. Whenever the mouse gets within the rectangle of a file or folder that entry is selected. De-selecting works the same, just start with the mouse over an already selected entry and press the left mouse button etc.

Unlike Windows Explorer, you can select files multiple times without the previous selection clearing. This is called sticky selection and enables you to easily select files in several parts of the folder list without the need to touch the keyboard at all.

Since the left mouse button is used exclusively for selection it means that only the right mouse button can be used for drag & drop. This is usually not a problem since dragging with the right mouse button presents you with a drop menu allowing you to choose whether to copy or move, and sometimes other actions as well, the selected files and folders.

Context menus works just like in other application by clicking the right mouse button.

Left mouse button: Sticky selection
Right mouse button: Drag & drop, context menus

Windows Explorer® selection

If you do not feel at home with the Magellan Explorer selection, then try the Explorer style selection instead. This selection method works just like in Windows Explorer, and in Windows applications in general, with a minor difference. Magellan Explorer normally uses it's own custom list view control which uses row selection, meaning a file can be selected even to the right of the displayed filename. Therefore, Explorer style selection with this list view will not allow you to select by dragging square boxes, instead you must rely on the SHIFT key to select a range of files by first clicking on the first file you wish to select followed by the second file, this time by holding SHIFT depressed.

To bypass this limitation it is possible to use the standard Windows list view control instead. In this
mode, selection works exactly like in Windows Explorer.

Drag & drop in this mode can be performed using either the left or right mouse button. When using the left button files/folders are either moved or copied depending on your configuration on the Defaults page in the User Interface preferences. When using the right mouse button the behavior is the same as in both the Magellan Explorer selection style above and Windows Explorer.

Left mouse button: Non-sticky selection (sticky with CTRL depressed), drag & drop  
Right mouse button: Drag & drop, context menus

**Norton Commander™ selection**

The final selection mode is designed primarily for users familiar with the Norton Commander or Total Commander (formerly Windows Commander) selection style. It is essentially the same as Magellan Explorer mode except the left and right mouse buttons are switched to perform selection with the right and drag & drop with the left.

Context menus are opened by holding down the right mouse button over an item for a short period.

Left mouse button: Drag & drop  
Right mouse button: Sticky selection, context menus (hold button depressed for a short time)

**Keyboard selection**

Together with either of the three selection modes outlines above you can also use the keyboard. This works the same in all modes. The UP/DOWN arrows as well as the PGUP/PGDN/HOME/END move the cursor box and SPACE toggles selection. Depending on your selection configuration you may need to press the UP/DOWN key for the cursor to initially appear in the list view.

**Selection tools**

In addition to the methods outlined above you can also make use of the selection tools within Magellan Explorer to quickly select or deselect a range of files and folders. See the Selection tools section for more information.

### 2.2 Using the built in tools

This topic will explain how to perform the basic file operations in Magellan Explorer using the built in tools. The examples assumes you use dual list view or explorer mode. The screenshots will show the former.

In this example we will show how to copy files. The same principle applies to other tools as well.

**How to copy files**

First you need to open the folder containing the files you want to copy. You can open it in either folder window. We will refer to this folder window as the source window.

To locate the folder double-click on the hard drive in My Computer and then double click on the correct folder until you reach your destination. Alternatively you can select the appropriate drive from the Drive Bar and then navigate down the folder hierarchy in the folder window.
Once you have found the files you want to copy, you need to select them. This can be accomplished in variety of ways. If you use the Magellan Explorer default you only need to click on the files you want to copy once.

To select multiple files in one go hold down the left mouse button over the first file and drag the mouse over the other files. De-selecting works the same way by clicking or holding down the mouse button on a selected file and dragging the mouse.
As you can see on the screenshot above, 3 of the files are selected.

The next step is to open the destination folder in the other folder window. Use the same procedure as you did when finding the source folder.

Once both the source and destination folder windows have been loaded, and files have been selected in the source window you must let Magellan Explorer know which window is the source. The window currently acting as the source window is the one with a colored (active) box, the label box, above the list view. The figure below illustrates what an active label box looks like.

To activate the correct folder window click on the label box above it. You can also use the TAB key to switch the active folder window between the left and right window.

The final step is to click on copy in the Button Panel (as seen on the screenshot above).
How to open files
You open files in the same way as in Windows Explorer, by double clicking on their name.

How to delete files
First find the files using the same procedure as outlined under the How to copy text. Next select the files you want removed. Make sure only the files you want deleted are selected. Then click on the Delete button, by default placed between the Move and View buttons on the toolbar.

If you have selected more than one file or a folder you will be asked to confirm the operation.

Important: Once deleted it may be impossible to recover the files. Keep backups of your data!

2.3 Working with archives

Working with existing archives
By default Magellan Explorer will open archives as if they were folders. This means that when you double click on a file with a supported archive extension the application you previously used (if any) will not be started. Instead the folder will be shown inside the folder window just as if it was a normal folder.

When inside an archive you may use most of the tools in Magellan Explorer on the contained files/folders as if they were located in a real folder and not an archive. In other words, Magellan Explorer lets you forget about archives and simply access them as folders.

Example: To extract a file select it and click on Copy. The file will then be placed in the destination folder.

If you prefer to continue using your old archive management application you may do so by changing the settings in the Archive group in the Preferences.

Creating new archives
To create a new archive open the archive menu and select an archive format from the Create new archive sub menu. This opens the New Archive dialog, shown below in basic mode. This mode enables you to pick a name for the new archive as well as selecting a folder to place the archive. By default the folder open in the active folder window is used.

If you would like the currently selected files (in the active folder window) to be automatically added to the archive when you click Create archive then check the Add selected files and folders to the archive check box.

After the archive is created, it will be opened in the active folder window. If you chose to have files added to the archive then these will be copied in the background and the folder window will be refreshed once copying is complete.
New Archive dialog

To access the advanced mode of this dialog click the Options button. This will expand the dialog to expose the options shown below.

Advanced new archive options

Compression level

The compression level is a tradeoff between speed and size. If you set the compression level to None or a low value then copying files to and from the archive will be faster, but the archive size larger. The compression level slider has 10 discrete steps ranging from the leftmost (0) to the rightmost (9). The default compression is 6 which offers a good tradeoff between speed and size.

Modified time and date

You may specify which date Magellan Explorer should set on the archive after files have been copied into it. This option is only available for some archive formats.

Password protection (ZIP only)

You may choose to password protect (encrypt) your archives. Click on the Set password button to
type in your desired password (max 69 characters). Please be aware that the password is case sensitive.

**Note:** The encryption algorithm used by Magellan Explorer is the same one used by the PKZIP 2.04g program. This type of encryption can resist attacks by amateurs if the password is well chosen and long enough (at least 16 characters) but it will probably not resist attacks by determined users or experts. Therefore, we suggest that you always use long passwords, and when possible, do not rely solely on this encryption system to protect sensitive data.

Spanning (ZIP only)
You may choose to have the resulting archive divided into smaller parts to make distribution easier (e.g. copying onto floppy disks or similar). By specifying a size in kB either by selecting a pre-defined size from the list or entering it manually then Magellan Explorer will ensure that no single file exceeds this size.

**Note:** In order to extract the archive you will need all individual files available.

### 2.4 Organizing favorites

**Creating a new favorite**
Creating a new favorite, also known as a bookmark, is done just like in any browser. Open the folder you wish to add to favorites and select **Add Current Folder** from the **Favorites menu**. You will be prompted for a new for the new favorite.

By default the favorite is placed at the end of the favorites list, e.g. as the last entry on the favorites menu. You can re-arrange the favorites menu as you want however.

**Tip:** Your favorites automatically become available as tools. You can place a favorite on any toolbar!

**Organizing favorites**

Please note that some of the features in this dialog are only available in the licensed full version. More information about this can be found in the **Bonus features** topic. Information on how to purchase a full version license is available in the **Order information** section.

To organize your favorites open the Organize favorites dialog from the favorites menu. The dialog consists of a tree view representing your favorites on the left and information on the currently selected favorite on the right. To move a favorite you can either drag & drop it to the new location, use the **Move Up** and **Move Down** buttons or use the **Move to folder** button.

The Create folder and Add separator buttons allow you to create sub folder (sub menus in the favorites menu) and separators, respectively. If you want to remove a bookmark select it in the tree and click on **Remove**. You may also remove a folder and its contents. Please note that you will **not** be asked to confirm this.

### 2.5 Customizing folders

You can specify how Magellan Explorer should present specific folders, and it will be remembered whenever you open a customized folder. The options you can customize are sorting, column layout and view mode as shown in the image below.
To customize a folder, first navigate to the folder you wish to customize. Then, based on how you want the folder to look, change the view mode from the view menu change the column sorting by clicking on the desired column to sort by and resize the columns as you like.

Once you have the folder set as you want it open the Customize Folder dialog from the view menu and check the options you want remembered. The last step is to decide what folders should be affected by this layout. You can choose between saving just the open folder, the open folder and any sub folders or all folders (e.g. make this the default layout).

**Tip:** Even though you customize a folder to include its sub folders, you can still customize any of the sub folders separately should you wish to.

**Note:** By default Magellan Explorer remembers the last folder layout used and applies that to any folder you load, except those explicitly configured using this dialog. The Save settings for all folder option is therefore not available, unless this feature has been disabled from the Customized Folders section in the Folder Windows preferences.

### 2.6 Using context menus

Magellan Explorer contains several context menus to help you be more efficient managing your files. This section aims to give you an overview of what functionality is available from these menus.

**File/folder context menu**

This context menu is invoked by right clicking on a selected file or folder. Depending on you selection configuration you may need to hold the right mouse button depressed for a second before the menu appears. This context menu applies to all selected files and folders, not just the one you clicked.

The file/folder context menu is the same as the one present in Windows Explorer, including any 3rdparty extensions you may have installed, with some additional functionality. Only functionality specific to Magellan Explorer will be covered here.

Magellan Explorer viewer
Launches the currently selected file in the built in viewer. This is equivalent to applying the View tool. If multiple files are selected then only the first file will be shown initially. You may use the slide show feature (full version only) to flip through all the selected files.

Copy selection to clipboard
This item copies the full path of the currently selected files and folders to the clipboard. You can then paste them into any other application as text.

**Note:** Only the paths are copied, not the actual files. To copy the files/folders use the Copy item.

Copy MD5 sums to clipboard
Magellan Explorer can calculate so called MD5 checksums for files. This is a 128bit "fingerprint" and can be used for comparing files by simply comparing fingerprints instead of comparing the files byte-for-byte. As with the paths above, the MD5 checksums are copied to the clipboard, optionally with associated filenames or full paths.

**Note:** Calculating MD5 checksums on large files can take some time as the entire file must be read.

Add to archive
This is the same as creating an archive from the archive menu. The selected files will be added to the archive automatically when clicking OK in the archive dialog.

Add to
You can easily add a single selected file to an archive using this item. It is only available when a single file or folder is selected.

Delete, Folder Size, Search, Split, Join and Rename
These items are equivalent to using the tools by the same names.

**Folder window context menu**
The folder window context menu is invoked by either right clicking on the label box above the folder window or right clicking an empty section after the last file/folder in the folder window (only possible when the folder window is not filled entirely). This context menu is also available by right clicking in the FTP information window, if open.

The contents of the context menu varies depending on whether the folder is a file system folder, an archive or an FTP site. However, all items available in this menu is also available from other menus so this section will not go into detail explaining them all.
Part III
3 **Step by Step Guides**

The guides contain step by step guides to some of Magellan Explorer’s features.

**Available guides**
- Adding tools to the Button Panel
- Adding tools to the Quick Bar
- Adding tools to the Tools menu
- Adding or modifying a keyboard shortcut
- Connecting to a FTP site

If you would like an explanation on how to perform basic operations such as Copy, Delete and open files, the topic Working with Magellan Explorer contains further information.

### 3.1 Adding tools to the main toolbar

**Step 1:** Select Options, Preferences and then Tools and Toolbars from the menu.

**Step 2:** Click on the button you want to add the tool to on the preview in the middle of the dialog.

**Step 3:** Choose the tool/function you want to add in the list called tools.

**Step 4:** Click on Add to selected button.

**Optional step**

**Step 5:** If the button already had a tool assigned to it you can make the new tool appear on the button by selecting it in the Selected button list and clicking on the arrow up button until that tool is at the top. Any other tools listed below will be available from the drop down box on that button on the toolbar.

Click on OK at the bottom of the dialog and you're done!

### 3.2 Modifying the quick/navigation Bar

**Step 1:** Select Options, Preferences and then Tools and Toolbars from the menu.

**Step 2:** Click on the Quick Bar (or Navigation Bar) tab.

**Step 3:** Choose the tool/function you want to add and select it.

**Step 4:** Click on the button called Add to the Quick Bar (or Add to Navigation Bar).

**Optional step**

**Step 5:** Move the new item to its desired place by using the left and right arrow buttons.

Click on OK at the bottom of the dialog and you're done!
3.3 Modifying the tools menu

**Step 1:** Select Options, Preferences and then Tools and Toolbars from the menu.

**Step 2:** Click on the Tools menu tab

**Step 3:** Choose the tool/function you want in the tree view on the left and select it.

**Step 4:** Click on the Add tool button to place it in the tree view on the right.

**Optional step**

**Step 5:** Move the new item to it's desired place by using either the up and down buttons or by using drag & drop..

Click on OK at the button of the dialog and you're done!

3.4 Modifying a keyboard shortcut

**Step 1:** Select Options, Preferences and then User Interface from the menu.

**Step 2:** Click on the tab names Keyboard.

*If you want to modify/add a shortcut to a Tool*

**Step 3:** Select the tool in the tree view on the left.

**Step 4:** Click on the box below the list.

**Step 5:** Press the keyboard combination you would like to assign to the tool.

Click on OK and you're done!

3.5 Connecting to an FTP site

**Step 1:** Click on FTP on the menu.

**Step 2:** Click on Connect.

**Step 3:** Type in the address of the FTP site in the Address field.

**Step 4:** If it's an Anonymous site skip step 6

**Step 5:** Choose I have an account on this machine and type in the user name and password

*Optional*

**Step 6:** Type in the port number of the site (advanced users only)

Click Connect to site and you should be connected to the FTP site within seconds!

To avoid retyping all the information it's often wise to add your sites to the [Site Manager](#). This can be
done after you have selected by choosing Add to site manager from the Current session menu in the FTP menu.
4 Reference

The reference section of the manual is divided into the following sub sections.

- Default keyboard shortcuts
- Command line options
- Glossary
- Windows
  - The Progress Window - Displays progress information during file operations
  - The Viewer Window - Viewing files
  - The FTP Information Window - Detailed FTP session log information
- Menu bar
  - File menu - Selection context menu similar to Windows Explorer
  - View menu - Change current view, filtering and selection
  - Favorites menu - Organize your favorite folder, archive and FTP folders
  - FTP menu - Connect to and organize your FTP sites
  - Archive menu - Create and manage compressed archives
  - Tools menu - Provides access to the extensive tool chest
  - Options menu - Configure Magellan Explorer to suit your taste
  - Window menu - Organize you Magellan Explorer windows
  - Help menu - Help, upgrades and ordering information
- Toolbars
  - Main toolbar - The main toolbar provides easy access to your most used tools
  - Drive Bar - The drive bar makes it easy to jump to any drive on your disks
  - Navigation Bar - The navigation bar provides convenient navigation aids
  - Quick Bar - The quick bar is a context sensitive bar consisting of tools of your choice
- Tools
  - Basic tools - The basic and most important tools
  - File Manipulation - Advanced file manipulation tools
  - Advanced tools - Other advanced tools
- Preferences
  - User Interface - Appearance and user interface settings
  - Folder Windows - Folder window appearance and usage settings
  - Tools and toolbars - Tools, toolbars and tools menu configuration
  - Miscellaneous - Miscellaneous configuration options
  - Folder - Local and network folder specific settings
4.1 Default keyboard shortcuts

The default Magellan Explorer 3 shortcuts are listed in the tables below. You can configure the shortcuts any way you like in the Keyboard section in the User Interface preferences, however.

### Tool shortcuts

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>CTRL+C</td>
</tr>
<tr>
<td>Delete</td>
<td>DELETE</td>
</tr>
<tr>
<td>Search</td>
<td>F3</td>
</tr>
<tr>
<td>Folder Size</td>
<td>SPACE</td>
</tr>
<tr>
<td>FTP Connect</td>
<td>CTRL+F</td>
</tr>
<tr>
<td>Group Rename</td>
<td>CTRL+F2</td>
</tr>
<tr>
<td>Invert Selection</td>
<td>CTRL+I</td>
</tr>
<tr>
<td>Move</td>
<td>CTRL+M</td>
</tr>
<tr>
<td>My Computer</td>
<td>F4</td>
</tr>
<tr>
<td>New Folder</td>
<td>INSERT</td>
</tr>
<tr>
<td>Quit</td>
<td>ALT+F4</td>
</tr>
<tr>
<td>Refresh</td>
<td>F5</td>
</tr>
<tr>
<td>Rename</td>
<td>F2</td>
</tr>
<tr>
<td>Select</td>
<td>CTRL+S</td>
</tr>
<tr>
<td>Select All</td>
<td>CTRL+A</td>
</tr>
<tr>
<td>Select None</td>
<td>CTRL+N</td>
</tr>
</tbody>
</table>

### Other shortcuts

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change active folder window</td>
<td>TAB</td>
</tr>
<tr>
<td>Loads source folder in target folder window</td>
<td>CTRL+TAB</td>
</tr>
<tr>
<td>Navigate to parent folder</td>
<td>BACKSPACE</td>
</tr>
<tr>
<td>Minimize Magellan Explorer</td>
<td>F12</td>
</tr>
<tr>
<td>Open drive on Drive Bar</td>
<td>CTRL+1 to CTRL+0</td>
</tr>
<tr>
<td>Load active folder in other folder window</td>
<td>CTRL+TAB</td>
</tr>
<tr>
<td>Set keyboard focus to path box (w/o keyboard selection active)</td>
<td>ENTER</td>
</tr>
<tr>
<td>Set keyboard focus to filter box</td>
<td>CTRL+ENTER</td>
</tr>
</tbody>
</table>

4.2 Command line options

The following command line options are available:
### 4.3 Glossary

**Archive**

An archive is a collection of files and folders which are compressed and packed into one file. Popular archive formats include, but are not limited to, Zip, Rar, Arj, and Lha.

**Folder window**

The term folder window is used about the window that contains the file/folders (the screenshot above is of the upper part of a folder window). An active folder window, source window is the window that has the label box colored, blue on the image below.

![Folder window screenshot](image)

**Destination folder**

The destination folder is the folder that is open in the folder window which doesn't have a colored label box, as on the image below illustrates.
FTP

FTP (File Transfer Protocol) is a method for transferring files on the Internet. Normally the end-user will connect to a remote computer (a.k.a. server or site) set up by a company or organization and download files.

Folder window columns

The columns are located above the list of files in the folder window. Click on it to sort the folder window. The image below depicts the size column which is used to sort by size.

Wild card

The term wild card is often used about a pattern used to identify a group of files. A star (*) is used to indicate "all files" (thus * or *.* includes every file).

Examples

*.exe - All files with the extension .exe
a* - All filenames starting with an a

Label box

This box has two purposes. First of all it displays the label of the drive the folder is located in (or the name of the FTP site) in addition to the available space on that drive (unless it is an FTP site). Secondly it indicates which of the folder windows are active by coloring it.

Path box

The path box is the main edit box situated below the folder window. It shows the current path and allows you to enter a new path.

Filter box

The filter box is the smaller edit box to the right of the path box. You can apply filename pattern filters on the current folder contents by entering them here.
Label box context menu
A context menu for the currently loaded folder is available by right clicking the label box area.

Favorites
Favorites offer a convenient means to retrieve folders whose path or URL you've saved. The permanence and accessibility of favorites make them invaluable for personalizing your hard drive, archive and FTP access.

You store your favorites in a list that's saved on your hard disk, inside your registry. Once you add a bookmark to your list, the item stays until you remove it.

Regular Expression
A regular expression is a pattern that is matched against a subject string from left to right. Magellan Explorer uses the PCRE library to perform regular expression matches. Please consult the "PCRE REGULAR EXPRESSION DETAILS" section of the PCRE manual available at http://www.pcre.org/pcre.txt.

4.4 Windows
This section contains information on the following windows found within Magellan Explorer.

- The Progress Window - Displays progress information during file operations
- The Viewer Window - Viewing files
- The FTP Information Window - Detailed FTP session log information

4.4.1 Progress Window
The progress windows allows you to monitor and control any ongoing background file operation. The types of operations that can be run in the background and viewed in the Progress window include, but is not limited to, copying, moving and deleting files.

The window can configured to two different modes to reflect your need, Compact or Normal.

Compact
In this mode the window uses little screen estate while in many cases still giving sufficient progress information.

- An icon will appear in the upper left area indicating the type of operation (Copy, Move etc).
- The filename of the file being currently copied is displayed.
- The progress bar show how much of the total operation is done.
- The operation drop down allow you to select for which operation you want to view progress.
- Clicking on Abort will stop the operation being displayed.
- The Settings menu let you switch between the different modes, or hide or minimize the window.
  You may reopen a hidden window by selecting it from the View menu.

Normal
In Normal mode the window, shown below, has two progress bars. The first displays the progress for
the current file being processed, and the second show the progress of the total operation. If you have turned on additional progress information in the Preferences you may also see the speed of the transfer, given in kilobytes per second, and the time remaining.

![The Progress Window in normal mode](image)

The Progress Window in normal mode

The Normal mode gives you complete control of the operations and enable you to schedule any queue of operations that you have from the Queue Schedule tab. The tab gives you and overview of all the jobs in the queue, and the possibility to play, pause or abort any job.

**Note:** Please note that a FTP operation cannot be paused for a long while without getting aborted.

### 4.4.2 Viewer Window

**View window**

The built-in file viewer in Magellan Explorer let you quickly and easily view your files. In addition to standard text and hex viewing it supports many popular formats. These include

- ASCII files
- Hex viewing of any files
- Rich Text Format (RTF)
- GIF
- JPEG
- TIFF (CCITT 1D, G3 and G4)
- PNG
- Window Meta file (WMF)
- Windows Enhanced Meta file (EMF)
- PCX and DCX
- BMP
- DIB
- PIC
- TARGA
- Microsoft Office documents (1)
• HTML (2)
• PDF files through the Acrobat ActiveX control (2)

(1) Requires Microsoft Office ActiveX components and Internet Explorer 3.0 or higher

(2) Requires Microsoft Internet Explorer 3.0 or higher

The viewer can be used as a slide show viewer by selecting multiple files and then invoke the View tool. If only one file is selected, but multiple image files are available in the folder then you can start a slide show at any time by using the Next/Previous menu items described below.

Menu items
The following menu items are available in the viewer.

File

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Item description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Next</td>
<td>Show the next file in a slide show</td>
</tr>
<tr>
<td>• Previous</td>
<td>Show the previous file in a slide show</td>
</tr>
<tr>
<td>• Print</td>
<td>Prints the current file (text files only)</td>
</tr>
<tr>
<td>• Edit</td>
<td>Launches the editor configured in the External editors preferences with the current file as input</td>
</tr>
<tr>
<td>• Delete</td>
<td>Deletes the currently open file</td>
</tr>
</tbody>
</table>

Edit

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Item description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Copy</td>
<td>Copies the selected text or image to the clipboard</td>
</tr>
<tr>
<td>• Select All</td>
<td>Selects all text in the file (text view only)</td>
</tr>
<tr>
<td>• Find</td>
<td>Finds the first occurrence of the string you are searching after (text view only)</td>
</tr>
<tr>
<td>• Find Next</td>
<td>Finds any occurrences after the first (text view only)</td>
</tr>
</tbody>
</table>

Image (image viewer only)

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Item description</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Actual Size</td>
<td>Zooms the image to its actual size (100%)</td>
</tr>
<tr>
<td>• Best Fit</td>
<td>Zooms the image to always fit entirely within the desktop resolution</td>
</tr>
<tr>
<td>• Custom Zoom</td>
<td>Checked if you have zoomed the image</td>
</tr>
<tr>
<td>• Rotate Clockwise</td>
<td>Rotates the image 90 degrees clockwise</td>
</tr>
<tr>
<td>• Rotate Counter Clockwise</td>
<td>Rotates the image 90 degrees counter clockwise</td>
</tr>
<tr>
<td>• Zoom In</td>
<td>Zooms the image by 20%</td>
</tr>
<tr>
<td>• Zoom Out</td>
<td>Zooms out the image by 20%</td>
</tr>
<tr>
<td>• Set as Desktop Background</td>
<td>Sets the current image as your desktop background/wallpaper</td>
</tr>
</tbody>
</table>
Tip: The image menu is also available in a context menu by right clicking on the image.

Options

<table>
<thead>
<tr>
<th>Menu item</th>
<th>Item description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hex display</td>
<td>You can view any type of file in hex format by clicking on this item. Click once more to return.</td>
</tr>
<tr>
<td>Word warp</td>
<td>Makes the viewer line break lines that are longer than what the window can display (text view only)</td>
</tr>
<tr>
<td>DOS/OEM Charset</td>
<td>Views the file in a DOS compatible charset (text view only)</td>
</tr>
<tr>
<td>Font</td>
<td>Customize the current (text view only)</td>
</tr>
<tr>
<td>Save current position as default</td>
<td>If you have a favorite place you would like the View window to be placed you can save both the position and size by using this option.</td>
</tr>
<tr>
<td>Remember position on exit</td>
<td>If this option is selected Magellan Explorer will open the View window in the position it was last time you used it.</td>
</tr>
<tr>
<td>Automatic position</td>
<td>This option makes the viewer automatically use the same size as the image (as long as it is smaller than the entire screen) and place itself over the Magellan Explorer window.</td>
</tr>
</tbody>
</table>

Note: The Automatic position option works slightly different in preview mode. However, if you enter the Preview Mode with this option on Magellan Explorer will try to find a place on your screen, to the right or left of its window, with enough room to display the window. If there isn't enough room available on either side it will be opened so that it covers half of the Magellan Explorer window.

Note: If the Hex mode was used by the Viewer as the default format, it means that this particular format isn't supported. If this is the case Magellan Explorer will switch to view the file as a normal text file if you deselect Hex display.

Tip: Please note that you can set up the view window to behave differently for Preview Mode and the View tool (i.e., you can use, say, Automatic Position for the Preview Mode and Remember position on exit for the View tool).

4.4.3 FTP Information Window

When connected to one or more ftp sites you may view all the ftp commands being sent and received by turning on the Log window in the FTP menu. If you right-click on the window the FTP menu will appear.

4.5 Menu bar

This section contains information on the main menu bar in Magellan Explorer. The following sub menus are available.

- File - Selection context menu similar to Windows Explorer
- View - Change current view, filtering and selection
• **Favorites** - Organize your favorite folder, archive and FTP folders
• **FTP** - Connect to and organize your FTP sites
• **Archive** - Create and manage compressed archives
• **Tools** - Provides access to the extensive tool chest
• **Options** - Configure Magellan Explorer to suit your taste
• **Window** - Organize your Magellan Explorer windows
• **Help** - Help, upgrades and ordering information

### 4.5.1 File

**Start new Magellan Explorer**
Launches another copy of Magellan Explorer.

The File menu also contains the context menu of the selected file(s), folder(s) or drive(s).

**Quit**
Closes the application. If there are any file operations still ongoing you will be asked to confirm.

### 4.5.2 View

**Toolbars menu**
You can enable and disable all the toolbars by selecting them on this submenu. The currently enabled toolbars will be shown with a check mark next to them.

**Toolbar menu**
The toolbar menu lets you choose the position of the main toolbar or turn it off altogether.

**Lock toolbars**
Toggles the gripper handles on the toolbars. These are the vertical handles seen to the left of each toolbar. When holding the mouse pointer above a gripper the cursor changes to a move/size symbol. This means that you can move the bar around by clicking on the gripper and holding the left mouse button down while dragging the bar to the desired position. Locking the toolbars disable these grippers.

**Filters**
You can create new filters and enable/disable existing files from this menu. To read more about filters and how to manage them [click here](#).

**Manage filters**
Opens the Filter dialog, allowing you to create a filter or edit an existing filter. See the [filter section](#) from more info.

**Create quick filter**
Opens the Filter dialog, allowing you to quickly create a temporary filter. See the [filter section](#) from
more info.

No filter
Turns off any filters that are currently applied to the active folder window.

List of filters
The list of filters that you have created. Selecting one will apply it to the active folder window.

**Views**
This part of the View menu lets you choose between displaying files as Thumbnails, Tiles, Icons, List, Details and Details (Magellan). Depending on the currently open folder some of these may not be available.

- Icons - Shows each file in the folder as a 32x32 icon
- List - Shows each file in the folder as a 16x16 icon
- Details - For local folders this view is the same as details view in Windows Explorer showing detailed information about each file. For archive or FTP folders this view maps to the internal Magellan Explorer details view.

The following views are not supported inside archives or on FTP sites.

- Thumbnails - Shows a thumbnail image for each file in the folder.
- Tiles - Shows a tiled view of all files in the folder.
- Details (Magellan) - Displays detailed information about each file in the folder using the internal Magellan Explorer details view. For archive or FTP folders the Details view is the same view.

Please note that in all modes except Details (Magellan) (and Details in archives or FTP sites) the selection method is the same as in Windows Explorer regardless of your configuration.

**Select All**
Selects all files and folders in the active folder window. For more details see the [Select All](#) tool.

**Select None**
De-selects all files and folders in the active folder window. For more details see the [Select None](#) tool.

**Invert Selection**
Inverts the current selection in the active folder window. For more details see the [Invert Selection](#) tool.

**Pattern Select**
Selects files and folders in the active folder window based on pattern. For more details see the [Pattern Select](#) tool.

**Refresh**
Updates the contents of the active folder window. For more details see the [Refresh](#) tool.

**Stop**
Aborts any ongoing file operation. For more details see the [Stop](#) tool.
Customize Folder

Allows you to customize the layout of this particular folder (and optionally its sub folders). For more details see the section on customizing folders.

4.5.3 Favorites

Add current folder
You add the current folder to your favorites even if it's on an FTP site or inside a compressed archive.

Organize favorites
Opens the Organize Favorites dialog where you can manage your favorites. See the Organizing favorites section for more information.

4.5.4 FTP

Connect...
Opens the FTP Quick Connect dialog and enables you to connect to an FTP site that is not in your Site Manager.

Disconnect
Logs you off the currently connected FTP server in the active folder window.

Current Session
Changes made here applies only to the current connection.

Keep connection alive
You may toggle Keep connection alive and change the transfer mode. For more information on these topics see and FTP Advanced.

Use more than one connection
By default Magellan Explorer will try to upload and download files in a separate thread. If the site allows this, you are able to continue browsing the site while the transfers are progressing.

Magellan Explorer will only try to open a new connection once before using the main connection. If you want to avoid using more than the main connection turn this option off.

Transfer type
You can switch between ASCII, Binary and Auto.

There are two different ways of transferring files from (or to) a FTP site. These are called binary and ASCII. As general rule it is always wise to use binary when transferring data files and ASCII when transferring text files.

When setting the transfer type to Auto detect Magellan Explorer will switch between these modes depending on the extension of the file being transferred. You can configure the which extensions should be transferred as ASCII on the FTP Advanced tab.
Upload case

Unlike the Windows file system(s), the file system on UNIX ftp servers are usually case sensitive. This means that text.txt and Text.txt are two different files. If you would like Magellan Explorer to force the case of any files you upload to a particular format you can choose to do so here.

Connections

This submenu gives you a list of all active connections. Just select one of them to open it in the active folder window.

**Note:** You may have up 10 connections at the same time.

Please note that the trial version is limited to 2 concurrent connections. More information about this can be found in the Bonus features topic. Information on how to purchase a full version license is available in the Order information section.

Log window

When connected to one or more ftp sites you may view all the ftp commands being sent and received by turning on the Log window.

4.5.5 Archive

**Create new archive menu**

Displays a submenu where you can select the type of archive you want to create. Please note that you need to have set up external compression programs in order to create Rar and Ace files. You can do this in the Preferences.

After selecting the archive format you will be presented with the New Archive dialog where you enter information about the archive. See the Working with archives section for more information on this.

**Install**

Today many applications are distributed in compressed form inside archives. The Install feature makes it easy to setup such programs on your system by automatically extracting the archive to a temporary folder and starting the installer without the need to first extract the archive.

**Note:** The archive should contain a file called either install.exe or setup.exe, otherwise this feature will not be available.

**Checkout**

When you select Checkout, Magellan Explorer will create a temporary folder and extract all the files within the open archive to this folder. This is convenient if you need to execute a program contained inside an archive and the install feature above is not sufficient (e.g. no file named install.exe or setup.exe).

**Note:** Any changes you make to these extracted files will not be automatically updated in the archive. You will have to update it manually.
4.5.6 Tools

The Tools menu contains some of the less frequently used tools. Selecting them from your the menu will achieve the same as clicking on the same tool on any of the toolbars.

The layout of the tools menu is fully configurable from the preferences in the Tools and Toolbars section by choosing the Tools menu tab.

Disk Tools

The disk tools menu gives you instant access to external 3rdparty disk tools as well as network drive mapping.

Format
Formats a disk in a drive of your choosing.

Scandisk
Checks for errors on a hard drive partition of your choosing. Available on Windows 95/98/ME only.

Defrag
De-fragments you hard drive partitions for increased performance.

Backup
Enables you to easily backup your files using the Microsoft supplied backup utility. Available on Windows NT/2000/XP only.

Map Network Drive
Maps a network drive as logical disk with a drive letter on your system. More information can be found by pressing F1 once you have opened the dialog.

Disconnect Network Drive
Allows you to disconnect a previously mapped network drive. More information can be found by pressing F1 once you have opened the dialog.

System Tools

This menu contains some external 3rdparty system tools. They are System information, Edit registry and Edit system files. These options will start the given system tools if present.

Command Prompt from here
Opens a command line window with the path from the active folder window.

External tools

This menu contains links to some other 3rdparty tools you may wish to install. They are DiskState, Print Folder Pro and SuperCat. For more information see their respective homepages by clicking the links below.

DiskState
Print Folder Pro
Super Cat
**Magellan Explorer Tools**

The remaining tools are all internal Magellan Explorer tools. By default the tools listed are the following (click on links for more information).

- **Attribute**
- **Describe**
- **Clone**
- **Split**
- **Join**
- **Encode**
- **Decode**
- **Folder Size**
- **Group Attribute**
- **Group Rename**
- **Search**
- **Virtual Folder**
- **Synchronize**
- **Folder Compare**
- **Print Folder**

**4.5.7 Options**

The first four sections encompass global configuration options.

**User Interface**

This section contains settings relating to the appearance and user interface of Magellan Explorer. The following areas are covered by this section: Defaults, Colors & Fonts, Display, Keyboard, Confirmations, Selection and Advanced Selection.

**Folder Windows**

This section contains settings relating to folder window appearance and usage. The following areas are covered by this section: General, Startup, Advanced and Customized folders.

**Tools & Toolbars**

This section contains settings relating to toolbars, menus and external tools. The following areas are covered by this section: Toolbar, Navigation Bar, Quick Bar, Drive Bar, Tools menu, Custom tools and External editors.

**Misc**

This section contains miscellaneous settings that do not fit in any of the above sections. More specifically, the following areas are covered by this section: Find and filter, Progress, Performance, Shell integration, Auto update, History and Miscellaneous.

The next three sections contain options that are specific to file system folders, archives and FTP folders.

**Folders**
This section contains settings that apply only to file system folders. The following areas are covered: General, Attribute and Advanced.

FTP
This section contains settings that are specific to FTP folders and sites. The following areas are covered: Defaults, File transfer, Proxy and Advanced.

Archives
The archive section contains archive specific settings. The areas covered here are: General, ZIP, ACE, Rar, Arj and Lha and Cab and UNIX formats.

Save window size and position
Sets the current window position and size as default so that the next time you start Magellan Explorer it will retain the current size and position.

Set active folder window as default startup folder
The currently open folder in the active folder window is set as a startup folder for that window. The next time you start Magellan Explorer this folder will automatically be loaded there. You can specify this individually for both folder windows.

Import configuration from file/Export configuration to file
The last two options, Import and Export, enable exporting and re-importing your configuration. This is only available in the full version.

4.5.8 Window

Window Layout
This menu lets you choose the window layout you wish to use. First you must decide whether to use a list view only layout or the Windows Explorer style layout with a tree view on the left and list view on the right.

Both these layouts can be used as either a single window with one folder window or a dual window layout. In dual window layout you can choose how you would like the two windows arranged, either side by side or one above the other.

The recommend window layout is to use two windows, either in list view only mode or in explorer mode.

Progress Window
Selecting this item will open the Progress Window.

Preview Mode
The Preview Mode was designed to let you view files easily and quickly. When you select it the View window will open and all files you select will be opened automatically inside it.

Please note that if you just want to view one file you can use the View tool instead.
4.5.9 Help

Contents
Displays an overview of the help system.

Step by Step Guides
Gives you a list of available guides. The guides are available here.

Purchase Magellan Explorer
Starts the Order Wizard. It will guide you through the easy steps of purchasing Magellan Explorer. We accept orders from all over the world using a multitude of different payment options. This wizard will help you locate the best ordering method and location for you.

Magellan Explorer on the web
This menu links to useful Magellan Explorer web pages on the Enriva Development website.

Check for updates on the web
Magellan Explorer can check for updates and new versions if you allow it. If a new version has been found you are given the option to have Magellan Explorer upgrade itself by downloading and applying the upgrade automatically.

In addition to checking manually, you can also set Magellan Explorer to automatically check for new versions on startup. See the Auto update preferences sections for details on configuring this feature.

About Magellan Explorer
Displays a dialog box containing credits, acknowledgements and copyright information.

4.6 Toolbars

This section will familiarize you with the different toolbars available in Magellan Explorer. The following toolbars are available.

- Main toolbar - The main toolbar provides easy access to your most used tools
- Drive Bar - The drive bar makes it easy to jump to any drive on your disks
- Navigation Bar - The navigation bar provides convenient navigation aids
- Quick Bar - The quick bar is a context sensitive bar consisting of tools of your choice

4.6.1 The main toolbar

The Main toolbar, also referred to as just the toolbar, is one of the most central and important elements in Magellan Explorer. Almost every file operation may be accomplished by clicking on the appropriate tool on the panel. The image below shows the default layout on the main toolbar.

Accessing all the tools on a button
Some of the buttons have a drop down arrow to the right of the caption. This indicates that the button has more than one tool assigned to it. By clicking on the arrow a list of tools will appear. Simply select the tool from the list to use it.

If you would like it is also possible to access one of the secondary tools on a button by clicking with the right mouse button on that particular button. It is necessary to configure this yourself as the default setup doesn't have these assignments.

**Modifying the main toolbar**

Just about everything on the toolbar may by customized, some options even individually for each button. This includes color, font and tools. For more information about this see the [Preferences](#) section.

**Related topics**

Preferences: [Toolbar](#)

### 4.6.2 The drive bar

The Drive Bar provides easy access to all your local and network drives as well as Network Neighborhood. Simply click on the desired drive and the active folder window will load that folder.

Right clicking a drive on the Drive Bar opens the standard context menu for that drive. To refresh the Drive Bar to reflect any changes click on an empty area of it, or on any of the other tool bars or the menu bar, using the right mouse button and choose **Refresh Drive Bar** from the menu.

You may also turn it on or off from the same menu by toggling the Drive Bar item.

**Related topics**

Preferences: [Drive Bar](#)

Tools: [My Computer](#)

### 4.6.3 The navigation bar

The Navigation Bar is used to hold navigation aids, like back, forward and history. In addition it may contain any other tool of your choice. The Navigation Bar is highlighted on the image below.

**Note**: If the history tool is placed in the Navigation Bar then it will show a global history, rather than a history local to the active folder window.

**Related topics**

Preferences: [Navigation Bar](#)
4.6.4 The quick bar

The Quick Bar is the ideal place for tools you use frequently when manipulating the contents of the folder window. Each folder window has its own Quick Bar so there is no need to first activate the folder window before using, the Quick Bar always operates on the folder window below it.

Note: If the history tool is placed in the Quick Bar then it will show the local history of folder window below it. If you want to have global history use the history tool on the Navigation Bar.

Related topics
Preferences: Quick Bar

4.7 Tools

This section will describe the tools available in Magellan Explorer. It is divided into the following sub sections.

- Basic tools - The basic and most important tools
- File Manipulation - Advanced file manipulation tools
- Advanced tools - Other advanced tools

4.7.1 Basic tools

This section covers the most basic tools in Magellan Explorer. It is divided into the following sub sections.

- File selection
- Folder navigation
- Copying and moving files
- Deleting files
- Renaming files
- Modifying attributes
- Other operations

4.7.1.1 File selection

Magellan Explorer offers several tools to easily manage the selection of large number of files in a list view. These tools are explained in this section.

Select All
Selects all the files and folders in the active folder window.

Default shortcut key: CTRL+A
Select None

De-selects all the files and folders in the active folder window.

**Note:** It is possible to let a single click with the left mouse button on an empty area in the folder window equal a Select None operation. You'll find this option on the Selection page in the User Interface preferences.

Default shortcut key: **CTRL+N**

Invert Selection

Inverts the selection in the active folder window. All files that are selected becomes deselected and visa versa.

Default shortcut key: **CTRL+I**

Select Pattern

Displays this dialog box asking for a wild card or regular expression pattern. Clicking Select will select all files in the active folder window that match the pattern. Similarly, if Deselect is clicked then the files matching the pattern will have their selection removed.

**Note:** Files and folders that was selected/unselected prior to this operation will keep their state if they were not affected by the pattern.

If you want to select only the files affected by the pattern and have all other files unselected you need to explicitly unselect all files prior to invoking this tool, either using the Select None tool or by mouse or keyboard selection. The same applies in the reverse case where you want all files selected except the ones that match the filter. You would then first select all the files and then use the Select Pattern tool.

Shortcut key: **CTRL+S**

Related topics

- Step by Step Guide: [Adding tools to the toolbar](#)
- Step by Step Guide: [Adding tools to the Quick/Navigation bar](#)
- Step by Step Guide: [Adding or modifying a keyboard shortcut](#)
4.7.1.2 Folder navigation

Magellan Explorer offers browser like navigation functionality with back and forward buttons as well as folder histories and other convenient tools for navigation. These are all explained in this section.

**Parent**
The parent tool takes you to the parent folder, one step up in the folder hierarchy, of the current folder.

Default shortcut key: BACKSPACE

**Root**
Navigates the active folder window to the first level (root) of the current drive or FTP site.

**Back**
Navigates the folder window back to the previous folder you had open.

**Forward**
Navigates the folder window forward in the history if you have previously gone back.

**History**
Displays a list of recently accessed folders, archives and FTP sites. When invoked from the quick bar it presents a history local to the active folder window, e.g. only contains folders you have visited in that window. When invoked from other places, e.g. the navigation bar this tool presents a global history encompassing both folder windows.

**Stop**
Stops ongoing foreground operations that occur in the active folder window.

Default shortcut key: ESCAPE

**Refresh**
The Refresh tool updates (refreshes) the active folder window with new and/or changed files.

Folders on your local hard drive should be automatically refreshed when a change is done. However there may be times when folder contents is out of synch and a manual refresh is required.

Magellan Explorer will not automatically detect changes made by other programs/users on FTP sites and network drives. If you suspect that the content of such folders have been modified use the Refresh tool to bring the folder up to date. Furthermore, to reduce FTP latency the remote folder is not automatically refreshed after performing file operations. Instead, new files are added with limited information (no size, date, attributes etc) and deleted files are removed. Performing a refresh will update the folder window.

**Note:** Leaving and re-entering a folder will **not** necessarily refresh the contents.

Default shortcut key: F5
My Computer
Displays a list of all the drives (hard drives, removable devices, mapped network drives etc) on the system in the active folder window.

Tip: You can also access your drives easily directly from the drive bar.

Default shortcut key: F4

Mirror Folder
Loads (mirrors) the folder in the active folder window into the destination folder window.

Related topics
Step by Step Guide: Adding tools to the toolbar
Step by Step Guide: Adding tools to the Quick/Navigation bar
Step by Step Guide: Adding or modifying a keyboard shortcut

4.7.1.3 Copying and moving files
Copying and moving files can be accomplished by either drag & drop or using the built in copy tools. The tools consist of Copy, Copy As and Clone for copying files and Move and Move As for moving files. These tools are explained in this section.

Drag & drop
Just like in Windows Explorer you can drag & drop files in Magellan Explorer also. By default, dragging with the right mouse button will present you with a drop menu allowing you to choose the action to be taken, usually copy or move, whereas dragging with the left mouse button will either copy or move depending on your settings in the Defaults page in the User Interface preferences.

Copy/Move
The second way to copy/move files is by using the Copy/Move tool. Depending on the window layout the behavior of this tool varies.

Dual window layout
The Copy/Move tool copies/moves all the selected files and folders from the active folder window to the destination folder. If the active folder window contains an archive and not a folder, the copy operation extracts the selected files/folders into the destination folder. Similarly, if it is an FTP folder, the files/folders are downloaded into the destination folder.

Single window layout
Copying/moving files in a single window layout works the same as copy & paste (copy) or cut & paste (move).

Step 1: Select the files you want to copy or move.
Step 2: Right click to get the context menu, and choose copy/move or click on the Copy/Move tool on the toolbar.
Step 3: Open the destination folder and right click on the label box. Choose Paste from the menu.

Default shortcut keys: CTRL+A (copy) and CTRL+M (move)
Copy As/Move As

The Copy As/Move As tool is a slight variation on the Copy/Move tool and enables you to copy/move and rename files/folders in one go.

Dual window layout

CopiesMoves all the selected files and folders from the active folder window to the destination folder and gives them a new name. A dialog, shown below, is displayed for each file asking for the new name. When copying folders with the Copy As/Move As tool you will be prompted for a new name for the base name of the folder, but not files and folders contained within. In other words exactly like renaming a folder after copying/moving it.

The Copy As dialog

Single window layout

Not supported, a normal copy/move will be performed as outlined above.

There is no default keyboard shortcut, but you may configure one on the Keyboard Shortcuts tab in the User Interface preferences.

Clone

The Clone tool makes another copy of a file/folder in the same containing folder as the original. A dialog box, shown below, is displayed asking for the name of the new file or folder.

The Clone dialog

Tip: Use this tool for making quick backup copies of files within the same folder by simply appending .bak or similar to the filename.

Related topics

Step by Step Guide: Adding tools to the toolbar
Step by Step Guide: Adding tools to the Quick/Navigation bar
Step by Step Guide:  Adding or modifying a keyboard shortcut

4.7.1.4 Deleting files

Removes all the selected files and folders in the active folder window and places them in the recycle bin, if enabled on the General page in the Folder preferences.

Deleting files can either be done by right clicking one of the selected files and choosing delete from the context menu, or by clicking the Delete tool on the toolbar. In both cases all selected files in the active folder window will be deleted, not just the last file clicked.

You may configure whether you should be asked for confirmation on the Confirmations page in the User Interface preferences. Furthermore you can chose to be prompted for confirmation when deleting certain system files on the General page in the Folder preferences.

Tip: Hold down the SHIFT key while clicking on Delete to bypass the recycle bin.

Note: Archive folder, network folders and FTP folders do not support the recycle bin. Files deleted from these files can thus not be easily recovered regardless of your recycle bin settings.

Default shortcut key: DELETE

Related topics

Step by Step Guide: Adding tools to the toolbar
Step by Step Guide: Adding tools to the Quick/Navigation bar
Step by Step Guide: Adding or modifying a keyboard shortcut

4.7.1.5 Renaming files

Magellan Explorer provides two powerful tools for renaming files, the Rename and Group Rename tools.

Rename

 Renames the selected files or folders. A dialog box, shown below, is displayed prompting you to type in the new name of the file or folder. If you select more than one file/folder the dialog is displayed once for each file/folder. Click Cancel to cancel the entire operation and Skip to skip the current file/folder.

Tip: If you would like to rename a batch of files using wild cards or perform a more advanced
renaming operation you can do this using the more powerful Group Rename tool described below.

Default shortcut key: **F2**

**Group Rename**

Renaming a group of files often requires a more advanced tool. The Group Rename tool is the answer. It supports 9 different rename modes to enable you to get the task done quickly and easily.

To use, first select the files you would like to rename using either the mouse or one of the selection tools, then invoke the Group Rename tool (available from the **Tools menu** in the default configuration). This will display the dialog shown below.

![The Group Rename dialog](image)

The dialog displays the files you have selected in the From column on the left. To perform a rename first select a rename mode from the drop down box, then fill one or both edit boxes (explained below) depending on the rename mode and finally click the **Preview** button. This will display the new names that will be assigned to the files in the To column on the right. Files not shown in the To column will be left untouched (i.e. same name as in the Front column). Once you are satisfied by the result click **OK** to have the rename operation performed.

The following rename modes, selectable from the drop down box in the dialog, are available.

**Extension**

The extension mode is the same as the old Group Rename tool from earlier versions of Magellan Explorer and allows you to change the extension of the selected files. Enter the new extension, without a leading period, in the **New extension** edit box. The image above shows an extension rename for all files to **bitmap**.

**Wildcards**

The wildcard mode allows you to specify two sets of wildcards, called the source pattern and target
pattern for renaming a file. The source pattern must match the original name using normal wildcard matching rules. The target pattern must be similar and the non-wildcard portion of the source pattern is replace by that of the target pattern.

For example, given the source pattern *.htm and target pattern *.html will rename the file "index.htm" to "index.html", but leave a second file "download.jpg" untouched since it does not match the source wildcard.

Regular expressions

Regular expressions (regexps) offers a more advanced version of wildcards capable of matching any text. It can be used to make advanced rename operations. More information on regular expressions are available here.

Performing a regexp rename consists of two expressions, similar to the wildcard rename. The source expression matches the existing filename and specifies what part of that name should be captured, or remembered, and which parts must simply match a specified string. The second pattern performs the desired substitutions based on the matched, and possibly captured, parts from the source.

For example, renaming all files with .htm extensions to .html could be performed with the source pattern set to (.*).htm and the target pattern to \1.html. The \1 will be substituted with the contents of the first parenthesis from the source pattern. Subsequent parenthesis matches would be \2, \3 etc. The \0 token will be substituted with the entire match.

Regular expressions (global)

Global regular expressions work the same as the regexps above, but can substitute several times within a single filename. Consider the regexps (.*)_\1 (source) and \1-\2 (target). Using the normal regular expression mode this would replace the first occurrence of a _ in the filename with a -. Using global regexps then all occurrences would be substituted.

Uppercasing filename

This mode simply uppercases all letters in the filename and extension.

Uppercasing extension only

Same as above, except for the extensions which is left alone.

Lowercasing filename

Similarly, this mode lowercases all letters in the filename and extension.

Lowercasing extension only

Again, same as above, but without changing the extension.

Capitalize filename

The final option will capitalize all separate words that occur in the filename. Given the two files "nice_file.txt" and "nice file2.txt" this option will convert them to Nice "File.txt" and "Nice file2.txt".
Tip: The best way to familiarize yourself with the features of the Group Rename tool is to simply play around with it and use the Preview button. No files will ever be renamed until you click OK.

Related topics
Step by Step Guide: Adding tools to the toolbar
Step by Step Guide: Adding tools to the Quick/Navigation bar
Step by Step Guide: Adding or modifying a keyboard shortcut

4.7.1.6 Modifying attributes

Modifying attributes within Magellan Explorer is done through the Attribute and Group Attribute tools. The former allows you to set individual attributes per file/folder selected, whereas the latter enables efficient modification of the attributes for many files in one go.

Attribute

The Attribute tool displays a dialog, shown below, contain the following general information about the selected file.

- File or folder location
- The file type
- The file size (unless it is a folder)
- The file or folder attributes
- The creation, modification and last access times
The Set Attributes dialog

You can alter either the attributes, one or more of the times & dates, or both. To alter the attributes make sure Modify the attributes of the file is selected and check the attributes you wish to set. Clear those you wish to unset.

Altering a date & time is done similarly by checking the appropriate check box next to the item you wish to change. Click on the date to open the calendar shown below to allow easy selection of a new date. Changing the time is done by either entering it directly or using the small up/down arrows.

Changing the modified date of a file

To set the date & time to the current date & time you can use the check box at the bottom marked Set time and date fields to current time and date. This saves you the trouble of having to do this manually. Please not that if you modify multiple time & date fields for the same file in one go and this option is selected then it will apply to all those fields.

When done click on OK to commit the changes or Cancel to discard the changes. If you had more than one file selected use Skip to skip the current file (and not save the changes) or Cancel to skip all the following files. Previously modified files will not be undone if you choose Cancel however.

**Attribute on FTP sites**

If you use the Attribute function on files/folders placed on a remote FTP system a slightly different version of the dialog, shown below, is used. This dialogs lets you set permissions, rather than attributes. Those familiar with the UNIX tool chmod will already be familiar with this.
The Set Attributes dialog for FTP folders

Assuming you have write access to the file you may change who should be allowed to read, write and/or execute the file/folder by clicking on the check marks. You can also change the permissions by typing in the octal number in the edit box.

For ease of use the three most common permission levels are instantly accessible as Private, Public and Open through the radio buttons at the top half of the dialog. Please note that a Public file has the Read permission set (744) while a folder has both Read and Execute (755).

**Group Attribute**

This tool work similar to the way attributes are set on multiple files/folders in Windows Explorer. The dialog is shown below.
The Group Attribute dialog

The check boxes have three states as outlined below.

- **Checked** - All the files and folders selected have this attribute set
- **Unchecked** - None of the files and folders selected have this attribute set
- **Square/grayed** - Some of the files and folders selected have this attribute set

This enables you to set/clear certain attributes (by checking or unchecking them) while leaving others untouched (by leaving them in the square state as seen in the above image for the Read-Only attribute).

**Group Attribute on FTP sites**

This works similar to on local files, except the attributes are replaced by permissions as explained above.

**Related topics**

- Step by Step Guide: [Adding tools to the toolbar](#)
- Step by Step Guide: [Adding tools to the Quick/Navigation bar](#)
- Step by Step Guide: [Adding or modifying a keyboard shortcut](#)

**4.7.1.7 Other operations**

These section describes other miscellaneous tools that you will almost certainly find useful.

**Backup**

Enables you to easily backup your files using the Microsoft supplied backup utility. Available on Windows NT/2000/XP only.

**Check Out** (archives only)

When you select Checkout, Magellan Explorer will create a temporary folder and extract all the files within the open archive to this folder. This is convenient if you need to execute a program contained inside an archive and the install feature above is not sufficient (e.g. no file named install.exe or setup.exe).

**Note**: Any changes you make to these extracted files will **not** be automatically updated in the archive. You will have to update it manually.

**Command Prompt**

Opens a command line window with the path from the active folder window.

**Defrag**

De-fragments you hard drive partitions for increased performance.

**Describe**

If you have turned on file comments on the General page in the Folder preferences Magellan Explorer can attach a comment to a file. These are shown in the right-most column in the folder window.
By selecting a file and clicking on Describe you will be asked to enter a comment. The comment will be stored in the description file (the name of the file can also be configured in the Preferences).

**Disconnect Network Drive**
Allows you to disconnect a previously mapped network drive. More information can be found by pressing F1 once you have opened the dialog.

**Extract** (archives only)
The Extract tool extracts can be used to extract archives without first opening them. This allows you to extract multiple archives in one go by selecting them and invoking this tool.

**Extract To** (archives only)
Similar to the Extract tool, but allows you to choose a destination folder for the archives, rather than using the other folder window as destination folder.

**Folder Size**
Calculates the space the selected folders, and their respective sub folders, occupy on the hard drive and displays the size in the Size column.

**Note:** Folder Size will add the size of hidden and system files to the total even if you have chosen not to display them.

It does not work on folders inside an archive.

Default shortcut key: SPACE

**Format**
Formats a disk in a drive of your choosing.

**Install** (archives only)
Today many applications are distributed in compressed form inside archives. The Install feature makes it easy to setup such programs on your system by automatically extracting the archive to a temporary folder and starting the installer without the need to first extract the archive.

**Note:** The archive should contain a file called either install.exe or setup.exe, otherwise this feature will not be available.

**Map Network Drive**
Maps a network drive as logical disk with a drive letter on your system. More information can be found by pressing F1 once you have opened the dialog.

**New folder**
Displays this dialog box, shown below, asking you for the name of the new folder. It is created in the folder/drive displayed in the active folder window.
4.7.2 File manipulation

This section covers several file manipulation tools available in Magellan Explorer. The section is divided into the following.

- **View and edit**
- **Encoding and joining**
- **Splitting and joining**

4.7.2.1 View and edit

View

The View tool will open all selected files using the built-in Magellan Explorer File Viewer. The following formats are supported:
• ASCII files
• Hex viewing of any files
• Rich Text Format (RTF)
• GIF
• JPEG
• TIFF (CCITT 1D, G3 and G4)
• PNG
• Window Meta file (WMF)
• Windows Enhanced Meta file (EMF)
• PCX and DCX
• BMP
• DIB
• PIC
• TARGA
• Microsoft Office documents (1)
• HTML (2)
• PDF files through the Acrobat ActiveX control (2)

(1) Requires Microsoft Office ActiveX components and Internet Explorer 3.0 or higher
(2) Requires Microsoft Internet Explorer 3.0 or higher

More information about the viewer window is available in the Viewer Windows section.

**View head**

The View head tool allows you to view only the first portion, referred to as the head, of a file. A dialog is opened prompting for the number of bytes to show.

**View tail**

The View head tool allows you to view only the last portion, referred to as the tail, of a file. A dialog is opened prompting for the number of bytes to show.

**Edit**

The Edit tool will open all selected files in an editor of your choice. The editor used depends on the file type and the editors configured in the External editors section in the Tools and toolbar preferences.

**Related topics**

Step by Step Guide: Adding tools to the toolbar
Step by Step Guide: Adding tools to the Quick/Navigation bar
Step by Step Guide: Adding or modifying a keyboard shortcut

**4.7.2.2 Encoding and decoding**

**Encode**

In Magellan Explorer 3.0 you now have the ability to ASCII encode, also known as ASCII armoring, binary files for easy transfer in emails and other media that do not deal well with binary files. The Encode dialog is shown below.
The Encode dialog

Several well known encoding formats are supported.

- **UUEncode**  The standard UNIX UUEncode format. Common filename extensions for this format are: .uue and .uu.
- **XXEncode**  The XXEncode format. An updated version of UUEncode which defines a better encoded character set. Common filename extensions for this format are: .xxe.
- **Base64**  The Base64 encoding format as defined by RFC-2045 and the XML specification. Used by the MIME format to encode email attachments. Common filename extensions for this format are: .b64.
- **BinHex**  The BinHex format as defined by RFC-1741. Commonly used on Apple platforms for encoding email attachments. Common filename extensions for this format are: .hqx or .bhx.
- **Quoted-Printable**  The Quoted-printable format as defined by RFC-2045. Often used to encode text in email.
- **Hexadecimal**  Plain hexadecimal encoding.

To use first select the encoding format followed by an output filename. A filename is suggested by Magellan Explorer and it is recommended that you keep the suggested extension to better identify the file format for later.

You can chose to have the source file automatically deleted after a successful encoding.

**Decode**

The decode tool allows you to decode previously encoded files. These may have been encoded by either Magellan Explorer or some other software. The decode dialog is shown below.
The Decode dialog

Decoding works the same as encoding, except you have the option to let Magellan Explorer auto detect, that is try to guess, the file type of the encoded files or specify the format yourself. If you know the format you should select it yourself, but the auto detection should in most cases be able to detect the format. An error will be shown if detection fails.

As with encode you have to option to delete the file after decoding.

Related topics

- Step by Step Guide: [Adding tools to the toolbar](#)
- Step by Step Guide: [Adding tools to the Quick/Navigation bar](#)
- Step by Step Guide: [Adding or modifying a keyboard shortcut](#)

4.7.2.3 Splitting and joining

Magellan Explorer can split files into smaller chunks. This is useful for transferring large files on media that do not have the capacity to contain the entire file at once. The files are then reassembled afterwards.

Split

Splitting files in Magellan Explorer is very straight forward. Simply select the file you wish to split, multiple files can also be selected, and click the Split tool. You will be presented with the dialog shown below.
The Split file dialog

The dialog lets you choose where to place the split file and the size of the split parts. By default the file is placed in the same folder as the file you are about to split as seen above where we attempt to split `Magellan.exe` contained in the Magellan Explorer 3 folder. The size of the parts can either be selected from one of the presents or a custom value can be entered. The custom value can be expressed as either bytes, kilobytes or megabytes using the drop down box.

As an example, consider what happens if we click OK in the dialog above. The file will now be split into files no larger than 512kB each. The image below shows the generated files `Magellan.exe.000`, `Magellan.exe.001` and `Magellan.exe.002` next to the original file `Magellan.exe`.

![Result of splitting Magellan.exe into 512kB parts](image)

Join

To re-join previously split files you use the Join tool. You can either first select all the parts of a previously split file or simply start the tool with no files selected. You can then add the parts you wish to join.

**Note:** You are responsible for locating all the parts and placing them in the correct order yourself. Magellan will not do this automatically, but it will try to guess to save you the work.

The Join dialog is shown below with all the files we previously split added to the file list on the left.
The Join files dialog

You can choose the filename for the joined file as well as the folder to save it in. By default it is the current folder in the active folder window. You may also choose to have the source files, the parts, deleted automatically after joining.

Related topics

- Step by Step Guide: Adding tools to the toolbar
- Step by Step Guide: Adding tools to the Quick/Navigation bar
- Step by Step Guide: Adding or modifying a keyboard shortcut

4.7.3 Advanced tools

This section covers advanced tools within Magellan Explorer. The section is divided into the following.

- Search and filter
- Folder Compare and Synchronize
- Virtual Folder
- Print Folder
- FTP tools

4.7.3.1 Search and filter

Magellan Explorer provides advanced search and filtering tools to help you quickly and easily locate the files you are looking for. This section explains the Search and Filter tools.

Search

When you invoke the Search tool you are presented with the Search dialog. The Search dialog has both a basic and an advanced view. The basic view is shown below.
The Search dialog - Basic mode

The Location to search

This field lets you narrow the search area. You can choose to search only in e.g. My Documents, on The Desktop or on a certain drive. Furthermore, the following search areas are also available.

- **Selected files and folders**: If you have selected any files, folders or drives in the active folder window.
- **Current folder**: Searches only in the folder open in the active folder window.
- **Current drive**: Searches every folder on the hard drive.
- **Local drives**: Searches every disk local to your system (e.g. not network drives)

Finally you may choose to select Browse which lets you select a specific folder to search.

All or part of the file name

Specify the file name(s) of the file(s) you want to find using [wild cards](wildcards). You can list several names by separating them with either a comma or a semicolon.

A word of phrase in the file

If you want to limit your search to files that include a specific phrase or a word it is possible by typing it here. The spelling must be correct to yield any result and the use of wild cards are not allowed. Do not put quotes around phrases.

**Note**: This criteria will be ignored on FTP sites.

**Search - Advanced mode**

In addition to the basic options explained above there is also an advanced mode that lets you further refine your search. The advanced options are revealed by clicking on the Options button in the Search dialog, and are shown in the image below.
The Search dialog advanced options

File Size
You can limit your search to files that meet a certain file size criteria. You can choose to limit by files that are larger, smaller or the exact size you define. The size can be expressed in either bytes, kilobytes, megabytes or gigabytes by using the drop down.

Modification date & time
You may limit your search to files modified on a specific date, on relative to a date. There are two ways of doing this.

The first option lets you choose to filter on files that are modified on, before and after a specific date & time as well as today, this week, this month and this year.

The second option lets you specify two dates & times and only files modified between those two dates & times are matched.

Advanced options

- Include sub folders With this option set the search will recurse into folders that are encountered.
- Include hidden files and folders You may choose to include hidden files & folders in the search
- The file name pattern above is a regular expression The file name pattern above can be expressed as a regular expression instead of a normal wild card pattern. Checking this box will allow that.
- The word or phrase above is a regular expression Same as above for word or phrase box above

Note: Defaults for some of these options can be set on the Search and filter page in the Miscellaneous preferences.

Once the search completes and if files have been found you will be presented by the Search Results dialog shown below.
In order to display the found files they must be opened in a virtual folder. You can choose to open it in either the left or right (or top or bottom depending on your layout) folder window or simply save it for later. You can also assign it a name and save it permanently in your virtual folder store.

**Filter**

The Filter tool allows you to reduce the number of files and folders shown in the folder window by filtering the files before display. Only files that match the filter is shown, other files are simply hidden from view. The Filter dialog can either be opened from the Filter tool or from the Filter menu in the View menu.

The Filter dialog is almost identical to the Search dialog explained above, and only the parts that differ will be explained here. The dialog in basic mode is shown below.

In the basic mode, the only differing factor is that the search location has been replaced by a filter name box and a delete button. This box lets you specify the name of the filter, since filters are saved. The drop down box lets you edit other filters you have previously created and the delete button will delete the selected filter.

**Note:** If you open the Filter dialog using the Quick Filter option you will not have to specify a filter name.
The advanced mode of the Filter dialog is identical to the Search dialog. The only difference being the Include sub folders option which now specify whether to display folders even when they do not match the filter criteria, or not.

When you have applied a filter it will be listed in the filter box next to the path box. To clear the filter either select No filter from that box, click on the Clear Filter tool in the quick bar or select No Filter from the Filter menu in the View menu.

**Clear Filter**

This tool clears any filter currently applied to the active folder window.

**Related topics**

Step by Step Guide: [Adding tools to the toolbar](#)
Step by Step Guide: [Adding tools to the Quick/Navigation bar](#)
Step by Step Guide: [Adding or modifying a keyboard shortcut](#)

### 4.7.3.2 Folder Compare and Synchronize

**Folder Compare**

The Folder Compare tool, known as Folder Synchronize in Magellan Explorer versions prior to 3.0, will select files according to criteria you define. The dialog is shown below.

![The Folder Compare dialog](image)

The tool provides two main options, Select files that exists in both folders and Select files that exists in one folder only.

The first option allows you to set which criteria should be used to select files. Files matching the criteria will then be selected in the active folder window. For instance you may want to select files with a newer date/time and then copy them manually to the destination folder afterwards.
The second option makes Magellan Explorer select files in both folder windows that do not have a matching file, i.e. a file with the same name, in the opposite folder window. Thus this function select "unique" files that exist only in one of the two folder windows.

**Note:** Please note that it is necessary to use either a dual list view or explorer mode to use this tool.

**Folder Synchronize**

The Folder Synchronize tool is a full blown synchronization tool that not only determines what files to synchronized, but also synchronizes them for you. To use, open the two folders you wish to synchronize, one in each folder window. You may also use the Browse buttons in the dialog to select the folders.

The next step is to determine what synchronization mode to use. The following modes are available.

- **Synchronize from source to destination only**
  This mode will copy new and modified files from the source to the destination folder.

- **Synchronize from source to destination and delete files not present in the source folder**
  Same as above, but files that exist only in the destination folder and not in the source folder are removed (from the destination folder). This is typically used to ensure the destination folder is identical to the source folder.

- **Bi-directional synchronization. Both folders are treated as both source and destination**
  This mode works similar to the first mode, but will reverse directions afterwards and ensure new or modified files in the destination folder are also copied to the source folder. Consider it a merging the two folders to both folders.

After deciding on the synchronization mode you can adjust some options that adjusts certain aspects of the synchronize operation. They are the following.

- **Overwrite options**
  You can choose to be prompted when an overwrite is to take place, automatically overwrite or never overwrite.

- **Prompt before deleting files**
  This option will give you a confirmation prompt before each file deleting. It is the second synchronize mode.

- **Display file copy log on completion**
  By checking this option a complete log of all files copied and deleted are shown upon completion of the synchronization.

- **Process sub folders**
  Determines whether only files in the current folders are affected, or whether folders are traversed recursively.

**Related topics**

- Step by Step Guide: [Adding tools to the toolbar](#)
4.7.3.3 Virtual Folder

A Virtual Folder contains links to the files/folders, and does not physically store the files in the folder. Invoking this tool presents the dialog shown below.

![The Virtual Folder dialog](image)

The dialog lets you assign a name to the virtual folder so that you can save it for later. Saving it is done by checking the Permanently remember this virtual folder check box. You can also choose how you wish the virtual folder to display filenames and whether files that no longer exist on your hard drive should be removed from the list when you open it.

To open previously saved virtual folders go to My Computer and then the Virtual Folders folder found there. Keep in mind that all opened virtual folders are available for the duration of a Magellan Explorer session, but only saved folders are available after a restart.

When using the Search tool to search for files it will open a Virtual Folder where it will place all the matching files.

To manually add files to a virtual folder simply use the Copy tool just as you would with any other folder. Removing files is performed similarly, using the Delete tool. You will be asked whether the files should only be removed from the virtual folder or actually deleted from disk also.

**Related topics**

- Step by Step Guide: Adding tools to the toolbar
- Step by Step Guide: Adding tools to the Quick/Navigation bar
- Step by Step Guide: Adding or modifying a keyboard shortcut
4.7.3.4 Print Folder

Magellan Explorer offers the ability to create text listings of folder contents, referred to as printing folders, to a file, the clipboard or a printer. The Print Folder dialog consists of a tabbed dialog with three sections; General, Recursion and Output.

General

The general tab of the Print Folder dialog is shown below.

The General tab lets you customize most aspects of what to print and what to ignore.

Output columns

You can select which columns you want to include in the output. Please note that file names will always be included.

Advanced options

- Only include folders
  - If you choose this option Magellan Explorer will output only folder names, not the files contained in them
- Calculate the size of folders
  - This option causes Magellan Explorer to output the size of all files within a folder next to that folder in the output
- Calculate and output total size
  - The size of all output files and folders are included at the end of the output
- Calculate MD5 sums of files
  - This option will cause Magellan Explorer to generate a 16 byte (128 bit) MD5 checksum for each file
- Use full paths
  - Each file is output with its full path. Otherwise just the file name is used.

Recursion
The second tab lets you configure the recursion of sub folders. A cutout of the results tab is shown below.

A section of the Recursion tab

You can specify whether folder recursion should be performed or not. If recursion is enabled then the contents of all folders are processed, and in turn their folders etc.

If you enable recursion you have the choice of three output formats. They determine how the output is presented and the best way to familiarize yourself with them is to simply print some folders and see for yourself.

**Output**

The output tab is the last step to printing a folder, and is shown below.

A section of the Output tab

This tab lets you specify where to send the output.

- **Printer** After pressing Ok the standard Windows printer dialog will appear where you can select which printer to use and other settings.
- **File** You can have the output written to a file instead of the printer. A dialog will appear after you have pressed Ok to request the filename.
- **Clipboard** If you would like to paste the output into another application you can choose to print the files and folders to the Windows Clipboard. To retrieve it select Paste in the application where you want it.

You can also choose how the output is to be sorted and also whether to use a parsable TAB delimited format instead of a human readable format. This is useful to e.g. import the list of printed folders into other applications.
You can further customize the output of time and sizes by clicking the Time & Size formats button. This will present the following dialog.

![The Time and size formats dialog]

This dialog lets you choose to use a custom date format, see the Advanced page in the Folder Windows preferences section for an explanation of how to customize a date format and the General page for an explanation on the file size display.

**Related topics**
- Step by Step Guide: [Adding tools to the toolbar](#)
- Step by Step Guide: [Adding tools to the Quick/Navigation bar](#)
- Step by Step Guide: [Adding or modifying a keyboard shortcut](#)

### 4.7.3.5 FTP tools

**FTP Connect**

Use this tool when you want to connect to an FTP site. You will be presented with the Quick Connect dialog shown below.
The FTP Quick Connect dialog

A description of the following elements follows.

Address
The address of the site (e.g. enriva.com). You may also specify it using the ftp://enriva.com format.

Anonymous vs. user specific login
Most FTP sites offer you to log on even if you don't have an account on the particular site. This is called Anonymous login. If you have an account select the second option and enter you user name and password.

The check box lets you tell Magellan Explorer not to store the password for security reasons. Magellan Explorer will "encrypt" the password before it's saved to disk. The algorithm used is not very secure and is only meant to keep the password from appearing as clear text.

Port number
You may configure the port the connection should use. Most normal FTP sites use port 21. If you are not familiar with ports it is recommended that you leave this value to its default number.

Retries
If you for some reason are unable to connect to a site (it is busy etc) Magellan Explorer may try to connect again either a fixed number of times or infinitely. You may also specify how long Magellan Explorer should wait before trying again.

Please note that setting the delay to a low value and the number of retries to a high number or infinitely (also called hammering) is not considered to be "good nettiquette" and may provoke a reaction from the FTP site maintainer.

Connect through a proxy
If you have configured a proxy on the Proxy page in the FTP preferences you may choose to use it
when connecting by checking this check box,

**Tip:** To avoid retyping all the information for sites you frequent it is recommended that you add your favorite sites to your site manager after you have logged in. See below for details.

**Tip:** Writing ftp://ftp.sitename.com in the Path Box will bring up the FTP Quick Connect dialog.

**FTP Disconnect**
Click on this tool will disconnect you from the ftp site in the active folder window.

**FTP Site Manager**
The Site Manager lets you easily manage your FTP sites in one place. There are several ways to add a new site to the site manager. The easiest is to simply connect to it using the FTP Connect tool and then choose Add current site to site manager from either the FTP menu or the label box context menu. The other alternative is to open the Site Manager and click the New Site button. Either way will open the Add/Edit Site. If opened using the former method then most fields will already be filled out and you need only enter a name for the site.

This dialog lets you fill out server details similar to what is found in the Quick Connect dialog above as well as a nick name for the site. This can be anything you like.

The options page contain several advanced options that you can set individually for each site in the Site Manager. By default they will be set to the same as the FTP preferences when you create the site. The options on this page are the same, except for a few, as those found on the Advanced page in the FTP preferences.

Once you have added the site you can connect to it either directly from the Site Manager dialog or from the Sites submenu in the FTP menu.

**Related topics**
Step by Step Guide: Adding tools to the toolbar
Step by Step Guide: Adding tools to the Quick/Navigation bar
Step by Step Guide: Adding or modifying a keyboard shortcut

**4.8 Preferences**

This section documents the different preference dialogs within Magellan Explorer.

The following four sections contain the overall preferences for Magellan Explorer.

- **User Interface** - Appearance and user interface settings
- **Folder Windows** - Folder window appearance and usage settings
- **Tools and toolbars** - Tools, toolbars and tools menu configuration
- **Miscellaneous** - Miscellaneous configuration options

The following three sections are specific to their individual folder types.

- **Folder** - Local and network folder specific settings
- **FTP** - FTP folder and server specific settings
4.8.1 User Interface

The following sections are covered by the User Interface preferences.

- **Defaults**
- **Colors and fonts**
- **Display**
- **Keyboard**
- **Confirmations**
- **Selection**
- **Advanced selection**

4.8.1.1 Defaults

The **Defaults** preferences page is accessed by selecting Options, followed by Preferences and finally User Interface from the main menu bar. This preferences page gives you the option to set the default state of some miscellaneous settings.

**Startup options**

Display splash screen (logo)

Specifies whether or not the splash screen is displayed during startup. Displaying the splash screen does not have any measurable effect on start up speed.

Start automatically with Windows

Check this option to have Magellan Explorer start automatically when Windows starts. In practice this means that Magellan Explorer is started after you log onto your computer.

Minimize to tray/taskbar after startup

You can chose to have Magellan Explorer start minimized in the taskbar or tray. Magellan will be minimized to either the taskbar or tray depending on the minimize setting on the **Display** tab.

**Drag & drop**

When using drag & drop you can set the default action to either Copy or Move. If you never use drag & drop you may disable it entirely in Magellan Explorer to prevent it from interfering by accident when selecting files.

You can also choose to deselect files after performing an drag and drop action with them.

**Label box look**

The active label box can be drawn using a gradient instead of a uniform color. You can choose between the following modes.
- Exponential - drawn from black (left) to a user defined color (right) with an exponential algorithm
- Linear - drawn from a user defined color (left) to brighter version of the same color on the right
- None - drawn as a uniform used defined color

To select the color you wish to use, please see the Colors and fonts tab.

4.8.1.2 Colors and fonts

The Colors and Fonts preferences page is accessed by selecting Options, followed by Preferences and finally User Interface from the main menu bar. Then click on the Colors & fonts tab at the top of the preferences dialog.

You can change the colors and fonts of many aspects in Magellan Explorer from this configuration page. The image below explains the different sections of the dialog.

To change the color or font of something in Magellan Explorer follow these simple steps (illustrated on the image).

**Step 1**: Choose the general element you wish to configure in the screen element list.

**Step 2**: Next choose which sub item you want to configure in the second list.

**Step 3**: Configure the item to you liking by altering the foreground and background color and font.

Your settings for the selected item is displayed in the preview box.

**Note**: Please note that you cannot change all three attributes (foreground color, background color and font) on all the items.
4.8.1.3 Display

The Display preferences page is accessed by selecting Options, followed by Preferences and finally User Interface from the main menu bar. Then click on the Display tab at the top of the preferences dialog.

Display in

You may configure Magellan Explorer to minimize itself to either the taskbar (standard Windows behavior), the system tray (located to the right of the taskbar) or both.

When resident in the system tray you can single click or double click to restore Magellan Explorer. If you right click the icon a menu will be displayed.

Please note that this features is only available in the licensed full version. More information about this can be found on the Bonus features topic. To get more information on how to purchase a full version license click here.

Tool tips

Checking this option will turn on or off tool tips globally within Magellan Explorer. You can also configure tool tips individually for each of the toolbars. See the Tools and toolbars section for details.

Title bar

By default Magellan Explorer will display only the name of the current folder before the dash in the title, but if you prefer it can show the complete folder path instead.

4.8.1.4 Keyboard

The Keyboard Shortcuts preferences page is accessed by selecting Options, followed by Preferences and finally User Interface from the main menu bar. Then click on the Keyboard tab at the top of the preferences dialog.

This page enables you to setup your keyboard shortcuts. Every tool in Magellan Explorer may be given a user specified, unique keyboard shortcut.

Tools and functions

To assign a shortcut to a tool begin by locating the tool in the tree view on the left. The tools are arranged into several sections to make finding them easier. Make sure the tool you wish to configure is selected. Next click inside the hotkey box below the tree view. A blinking cursor will appear in the box, indicating the focus.

Now you can press the keyboard combination you would like to set as a shortcut. To assign e.g. CTRL+A to the selected tool you first press and hold down the CTRL key followed by the letter A on your keyboard, then release both simultaneously. The string CTRL+A should be displayed in the hotkey box.

Note: Certain hotkey combinations cannot be input into the hotkey box and can hence not be used.

Special keys and functions

The other check boxes enables you to assign keyboard shortcuts that the hotkey box won't accept and also assign them to some other special functions that are not available as tools.
The space bar may have three different functions assigned to it, Folder Size, changing of active folder window or toggling of the active keyboard selection entry.

Click here to see a list of the default Keyboard shortcuts

4.8.1.5 Confirmations

The Confirmations preferences page is accessed by selecting Options, followed by Preferences and finally User Interface from the main menu bar. Then click on the Confirmations tab at the top of the preferences dialog.

Delete

Deleting files and folders are sometimes an irreversible action. This is always the case when working on remote network mapped folders, inside archives or on remote FTP sites. Depending on your recycle bin settings you may or may not be able to recover files deleted from your local folders.

It is recommended that inexperienced users leave these options in their default state.

By default Magellan Explorer will ask for confirmation when deleting more than one file, or one or more folders. You may change these settings by checking the appropriate boxes.

You may have files selected outside the visible area of the folder window that you are not aware of (this is especially true with when using sticky selection). Magellan Explorer can warn you every time you try to delete files that are outside the visible area if you check this option.

Copy & move

Magellan Explorer can prompt for confirmation whenever you attempt to move or copy files. This can be useful as a sanity check to ensure you have the correct folder window active etc. By default no confirmation is required for these actions.

Rename, Copy As, Move As and Clone

Magellan Explorer can also prompt for confirmation whenever you attempt to rename files. By default no confirmation is required for this action.

If you change the extension of a file you implicitly change the way Windows and your application interprets the contents. This may therefore render it useless by accident, unless you rename the file back to the original extension. Magellan Explorer can help prevent this from happening by issuing a warning whenever you attempt to change the extension of a file.

4.8.1.6 Selection

The Selection preferences page is accessed by selecting Options, followed by Preferences and finally User Interface from the main menu bar. Then click on the Selection tab at the top of the preferences dialog.

You can completely customize the way you select files in Magellan Explorer.

Up through the years several different methods have been used in a variety of products so it seems that everyone have their favorite way of selecting files and folders. By changing the settings on this tab you can emulate most of them.
Please note that changes made on this tab and Advanced Selection effect each other.

**One-Click Configuration**

If you have previously used and prefer the selection method of Windows Explorer or Norton Commander you may use it by clicking on one of the buttons. To restore the settings to factory default click on Normal.

**Details display**

To be able to support different selection methods Magellan Explorer comes with its own, custom folder window control. The look and feel of this is different from the standard Explorer/Windows folder window in some respects.

If you want Magellan Explorer to behave similar to Windows Explorer please choose the Explorer details option.

**File selection**

Select using

Default Windows selection uses the left mouse button, however Magellan Explorer offers the use of right mouse button as an alternative. If you prefer using the right mouse button when selecting files use this option.

**Note:** When using the right mouse button for selection the context menu can be displayed by holding the right mouse button down for approximately one second.

**Mouse Dragging**

Moving the mouse while holding down the button is called a drag. You can configure Magellan Explorer to either do a drag & drop action or select all the files you move the mouse cursor over when dragging using the same button selected above for file selection.

**Note:** The mouse button not used for selection will always be available for drag & drop (unless you have disabled it on the Defaults tab) no matter what option you use here. Therefore it is possible to use both drag selection and drag & drop with the same settings. This is also the default and recommended setting as it provides the most powerful way to work.

**Selection of multiple files**

When doing file management it is often necessary to select more than one file. By default this is easy in Magellan Explorer as you just select the files you want one after one (and your previous selections will remain). This is called sticky selection. To unselect files you must either manually select each file (optionally using drag selection) or using the Select None tool.

On the other hand, you may prefer the way Windows does this, using the CTRL and SHIFT keys. Unless you're holding down either Ctrl, Shift or both, a new selection will clear any other selections you may have made.

When holding down the SHIFT key all the files and folders between your old selection and the new selection will be selected (including the two mentioned). If you hold down the CTRL key then the previous selection becomes stays while you select new items.

Holding down both will expand the selection with the files between the already selected files and the
file you click on.

Keyboard selection
If you want to use the keyboard to select files then enable this option. If you only want the keyboard selector (a black outlined box) to appear when you press on one of the arrows keys then select the second alternative.

4.8.1.7 Advanced selection
The Advanced Selection preferences page is accessed by selecting Options, followed by Preferences and finally User Interface from the main menu bar. Then click on the Advanced Selection tab at the top of the preferences dialog.

You can completely customize the way you select files in Magellan Explorer.

Up through the years several different methods have been used in a variety of products so it seems that everyone have their favorite way of selecting files and folders. By changing the settings on this tab you can emulate most of them.

Please note that changed made on this tab and Selection effect each other.

One-Click Configuration
If you have previously used and prefer the selection method of Windows Explorer or Norton Commander you may use it by clicking on one of the buttons. To restore the settings to factory default click on Normal.

Details display
To be able to support different selection methods Magellan Explorer comes with its own, custom folder window control. The look and feel of this is different from the standard Explorer/Windows folder window in some respects.

If you want Magellan Explorer to behave similar to Windows Explorer please choose the Explorer details option.

File selection
Folder Memory
The following options only affects the folders in the folder memory of Magellan Explorer. You may specify the size of the folder memory at the bottom of the tab. By default Magellan Explorer remembers the contents and selection of the last 10 folders you have opened.

- Selection on focus change - If you make the other folder window active and later change back to the back then Magellan Explorer will remember your selection in the original folder window if this options is checked.

- Selection on folder change - If you select some files in a folder, open a new folder in the same folder window, and later come back to the original folder in either folder window then Magellan Explorer will remember your selection.

- Scroll bar position - If you use the scroll bar in a folder, open a new folder in the same folder window, and later come back to the original folder in either folder window then Magellan Explorer
will remember the position of the scroll bar.

- Number of folders to remember - Folders that are in the folder memory of Magellan Explorer will in addition to being able to remember it's state, load faster. However, increasing the size of the folder memory will result in bigger demand of system resources and is not recommended on normal systems.

Deselect files
- When clicking with the left mouse button on a empty area in the folder window - If this option is enabled files will be deselected if you click on the area below the last files if there isn't enough files to fill the folder window completely.
- After performing a file operation - By checking this option Magellan Explorer will automatically deselect files after you apply a tool on them (e.g. copy, rename).

4.8.2 Folder Windows
The following sections are covered by the Folder Windows preferences.

- **General**
- **Startup**
- **Advanced**
- **Customized folders**

4.8.2.1 General

The General preferences page is accessed by selecting Options, followed by Preferences and finally Folder Windows from the main menu bar.

**Drag and drop unto folders**

With Spring loaded folders enabled you don't need to open the destination folder or tree view branch before you start dragging files. Just drag the files you wish to copy or move over the folder containing the folder you wish to drop into and hold the cursor still for a short moment. The folder will then automatically open (if in the details view) or expand. Once you have located the destination simply drop the files as you would normally.

**Folder window file sizes**

You can configure the way Magellan Explorer displays file sizes in the folder windows.

- Show size in bytes - The exact size of each file is displayed in bytes with space separating every thousand.
- Show size in kilo bytes - The size is shown in kilo bytes (kB) rounded down. Files less than 1 kB is shown as 1 and not 0. Every thousand is separated by a space.
- Automatically format sizes - Format sizes automatically. Depending on the size it may be shown as bytes, kilobytes, megabytes and gigabytes. This choice implicitly enables the denomination check box as this becomes necessary to tell the size.

When showing file sizes in bytes or kilo bytes you may also opt to have the denominator (B or kB) appended to the display. This is always enabled if auto format is selected.
**General options**

Show parent entry first in every folder

If you use the Parent function to move up in the folder tree you may wish to remove the ".." entry automatically displayed at the top of every folder. The sole purpose of this entry is to enable double clicking it to go to the parent directory, nothing else.

Enable Quick Click Parent and Root

If you check this option Magellan Explorer will display a parent arrow to the right of the cursor when you move it to the left of the file names. A click with the left mouse button in this state will navigate the folder window one level up (parent).

**Tip:** To make this feature work you have to hit a very narrow area with the mouse for the cursor to change. It is most easily used if you have Magellan Explorer maximized.

Enable Quick Rename

If you click once on a file after selecting it you can rename the file within the folder window. This feature is found both in Windows Explorer and in Windows in general.

**4.8.2.2 Startup**

The Startup preferences page is accessed by selecting Options, followed by Preferences and finally Folder Windows from the main menu bar. Then click on the Startup tab at the top of the preferences dialog.

This page lets you configure what folders are loaded automatically on startup. There is a separate setting for the left and right (or top and bottom) folder windows.

- Show the desktop - The desktop is shown
- Show My Computer - The My Computer list (Disk drives and Network Neighborhood) is shown
- Show Favorites - Your favorite folders are shown
- Show folder open on last exit - The folder open the you last time you closed the program is re-opened
- Show other folders - Any other folder you wish to always open on startup can be configured

You can also specify a startup folder from the Options menu.

**4.8.2.3 Advanced**

The Advanced preferences page is accessed by selecting Options, followed by Preferences and finally Folder Windows from the main menu bar. Then click on the Advanced tab at the top of the preferences dialog.

The following settings are for advanced users only, and you should not change them unless you understand what you are changing. Changing any of these options are not necessary for normal operation in any way.

**Time & Date**

You have the choice of using the Windows default date format or specifying your own. Use the following format codes when customizing the time and date.
Abbreviated weekday name

Full weekday name

Abbreviated month name

Full month name

Date and time representation appropriate for locale

Day of month as decimal number (01 – 31)

Hour in 24-hour format (00 – 23)

Hour in 12-hour format (01 – 12)

Day of year as decimal number (001 – 366)

Month as decimal number (01 – 12)

Minute as decimal number (00 – 59)

Current locale's A.M./P.M. indicator for 12-hour clock

Second as decimal number (00 – 59)

Week of year as decimal number, with Sunday as first day of week (00 – 51)

Weekday as decimal number (0 – 6; Sunday is 0)

Week of year as decimal number, with Monday as first day of week (00 – 51)

Date representation for current locale

Time representation for current locale

Year without century, as decimal number (00 – 99)

Year with century, as decimal number

Time-zone name or abbreviation; no characters if time zone is unknown

Percent sign

Scroll bar position

If you would like to have the scroll bars centered (the scroll bar in the right folder window on the LEFT edge, and the scroll bar in the left folder window on the right edge as normal) it is possible.

General Options

Highlight destination folder window when dragging

By default dragging causes whatever folder window currently underneath the cursor to be activated (highlighted). This window then becomes the source folder window for the next operation. Depending on your pattern of use, this may be counter productive as you may have to re-activate the other folder window, and can therefore be turned off.

Delayed folder update

If you set the delayed folder update then Magellan Explorer won't refresh the contents of the folder windows when changes occur outside Magellan Explorer until you make it the active application (set focus). This is the recommended settings as it reduces unnecessary window updates in Magellan Explorer when you may not be using it.

Spacing

When using Magellan Explorer with a very large font then the space between the entries in the folder windows may be excessive. Using a lower value will decrease the spacing.
4.8.2.4 Customized folders

The **Customized folders** preferences page is accessed by selecting Options, followed by Preferences and finally Folder Windows from the main menu bar. Then click on the Customized folders tab at the top of the preferences dialog.

Magellan Explorer provides the option to customize the display of individual local and network mapped folders. More information about this feature can be found in the Customize Folder section.

This page displays your currently configured folders as well as what settings are customized for each. In order to customize a new folder or change the customization for an already customized folder you must exit the preferences and follow the explanation given in the Customize Folder section.

However, if you have already configured a folder and wish to apply the exact same configuration to a new folder you can do so using the Copy Selected Item button.

The current customization for a folder is shown on the right side of the dialog. It applies to the currently selected folder on the left side.

When the Automatically remember last layout option is enabled, Magellan Explorer remembers the last folder layout used and applies that to any folder you load, except those listed in this dialog. You can disable this feature and create your own default folder layout that should be used for such folders instead.

4.8.3 Tools and toolbars

The following sections are covered by the Tools and toolbar preferences.

- **Toolbar**
- **Navigation bar**
- **Quick bar**
- **Drive bar**
- **Tools menu**
- **Custom tools**
- **External editors**

4.8.3.1 Main toolbar

The **Toolbar** preferences page is accessed by selecting Options, followed by Preferences and finally Tools and toolbars from the main menu bar.

This page lets you configure the main toolbar. For more information on the main toolbar bar see the **Toolbars** section.

The main toolbar configuration is divided into three parts. To move from one to another click on the buttons at the top of the dialog, shown below.

![Toolbar sections](image)

**Add/Remove**
In this section you can add or remove tools from the buttons on the toolbar. You can also configure an individual drop down menu for each button if you choose. The image below shows a section of the Add/Remove part of the dialog.

How to add a tool

**Step 1:** First locate the tool you wish to add to the toolbar in the tree view containing available tools on the left.

**Step 2:** Next click on the button you want to add the tool to on the toolbar preview in the middle of the dialog. Then click on Add to button beneath the tools tree view on the left. The selected tool should now appear in the list.

If the button was empty before you added the tool the preview should now reflect the change.

You may also have more than one tool assigned to each button. The first tool in the list will appear on the toolbar and will be accessible by a normal left mouse click. All other tools will be on a drop down list unless they are configured as right mouse button tool. To make a tool available with the right mouse button, click on the mouse icon button underneath the selected button list.

How to modify a button

You may move tools up and down the drop down list clicking on the up and down arrows.

**Note:** A right mouse button tool cannot be the first entry and will automatically revert to a normal button tool if moved to the top.

How to remove a tool

Select it in the Selected button list and click on the delete button.

Appearance

In this section you can customize the general appearance of the main toolbar. All settings in this section apply to the toolbar in general and are not specific to individual buttons. The image below shows the appearance options.
Icons
One of the following icon modes can be selected.

- Large icons - Display each tool with a large 24x24 icon on the toolbar
- Small icons - Display each tool with a small 16x16 icon on the toolbar
- No Icons - Do not display icons on the toolbar, implies text labels

Size
The size of the main toolbar may be set from 4x1 to 16x4. You may also completely remove it by checking "Turn off the toolbar."

Appearance
Any of the following options can be selected.

- Labels - Displays the name of the tool on the toolbar button
- Tool tips - Displays the name of the tool when you hold the mouse pointer above the button for a few seconds.
- Show hotkeys on buttons - Display the keyboard shortcut applicable for the tool in front of its name. E.g. "Ctrl+C Copy".

Colors
In this section you can customize the colors of the main toolbar. These settings apply individually to each button. This means you can configure different background and foreground colors to different buttons.

To change the color of a button follow the following steps.
Step 1: Click on either the foreground or background drop down and select the color you want
Step 2: Click on buttons in the toolbar with the left mouse button to paint the foreground color
Step 3: Click on buttons in the toolbar with the right mouse button to paint the background color

4.8.3.2 Navigation bar

The Navigation bar preferences page is accessed by selecting Options, followed by Preferences and finally Tools and toolbars from the main menu bar. Then click on the Navigation bar tab at the top of the preferences dialog.

For more information on the navigation bar see the Toolbars section.

Insert and remove items

To insert a tool select it from the tree view on the left and click on Add to navigation bar. The added tool will be displayed on the navigation bar preview on the right.

If you want to remove something from the navigation bar simply select it on the preview and click on the delete (x) button.

Layout

Modifying the order of the items on your navigation bar is simple. Select the item you want to move and click on either the left or right arrow buttons. The image below helps illustrate this.

![Navigation bar layout](image)

Appearance

Any of the following options can be selected.

- Enable the Navigation Bar - Toggles the display of the navigation bar on/off
- Labels - Enables display of tool labels
- Tool tips - Displays tool tips when you hold the mouse over a button

One of the following icon modes can be selected.

- Large icons - Displays large 24x24 icons
- Small icons - Displays small 16x16 icons
- No icons - Display no icons on the navigation bar. Implies label display.
4.8.3.3 Quick bar

The Quick bar preferences page is accessed by selecting Options, followed by Preferences and finally Tools and toolbars from the main menu bar. Then click on the Quick bar tab at the top of the preferences dialog.

For more information on the quick bar see the Toolbars section.

Insert and remove items

To insert a tool select it from the tree view on the left and click on Add to quick bar. The added tool will be displayed on the quick bar preview on the right.

If you want to remove something from the quick bar simply select it on the preview and click on the delete (x) button.

Layout

Modifying the order of the items on your quick bar is simple. Select the item you want to move and click on either the left or right arrow buttons. The image below helps illustrate this.

![Quick bar layout image]

**Appearance**

Any of the following options can be selected.

- Enable the Quick Bar - Toggles the display of the quick bar on/off
- Enable tooltips - Displays tool tips when you hold the mouse over the button
- Enable dynamic items - The contents of the quickbar automatically changes based on what folder is viewed

**Tip:** The dynamic Quick Bar feature enables a context sensitive Quick Bar. In addition to displaying the tools you have selected certain other tools may also be displayed. These include:

- Filter when the current folder supports having a filter applied
- Clear Filter when a filter is active
- FTP Disconnect when connected to an FTP server
- Install, Checkout and Extract To when viewing an archive

4.8.3.4 Drive bar

The Drive bar preferences page is accessed by selecting Options, followed by Preferences and finally Tools and toolbars from the main menu bar. Then click on the Drive bar tab at the top of the
preferences dialog.

For more information on the drive bar see the Toolbars section.

**Appearance**

One of the following icon modes can be selected.

- Large icons - Displays large 24x24 icons
- Small icons - Displays small 16x16 icons
- No icons - Display no icons on the quick bar. Implies drive letter or volume label

Any of the following options can be selected.

- Drive letter - Show the drive letters
- Volume label - Show the volume labels
- Tool tips - Enables tool tips

**Auto detect**

If there are certain drives you don’t want included in your Drive Bar you may exclude them by removing the check mark next to that drive letter.

### 4.8.3.5 Tools menu

The Tools menu preferences page is accessed by selecting Options, followed by Preferences and finally Tools and toolbars from the main menu bar. Then click on the Tools menu tab at the top of the preferences dialog.

This page allows you to configure the tools menu to suit your needs. Any tool including favorites and custom tools can be placed in the tools menu. For more information on the tools menu see the Menu section.

**Insert and remove items**

To insert a tool select it from the tree view on the left and click on Add Tool. The added tool will be displayed on the tree view on the right. This tree view represents the tools menu.

To re-arrange the order of items in the tools menu either use drag & drop or the up and down arrow buttons to reposition items. You can create sub menus and insert separators by clicking the Add submenu and Add separator buttons respectively. These will then be inserted after the currently highlighted item in the tree view on the right.

If you want to remove something from the menu use the remove button.

**Tip:** You can get help on the individual tools by selecting a tool in the tree view on the right and clicking the Tool Help button.

### 4.8.3.6 Custom tools

The Custom tools preferences page is accessed by selecting Options, followed by Preferences and finally Tools and toolbars from the main menu bar. Then click on the Custom tools tab at the top of the preferences dialog.

Please note that this features is only available in the licensed full version. More information about this
can be found in the Bonus features topic. Information on how to purchase a full version license is available in the Order information section.

Magellan Explorer gives you the ability to integrate your existing tools into the Magellan Explorer interface. Please note that you have to add the tool to a toolbar or the tools menu in order to access it (it will not be available from the Tools menu). See the Step by step guides for more information on how to do this.

Add
Click on add to create a new Tool. The trial version is limited to 3 tools, while in the full version one can have up to a 100 custom tools.

Command
Please specify the path of the application you want to run, or use the browse button to select it.

Arguments
The following substitutions can be used in the Arguments box:

%fn Filename
%FN Filename with full path
%ff Filename without extension
%FF Filename without extension with full path
%fe Filename extension (without ".")
%sp Source folder path
%tp Target folder path
%rs String requester
%rf File requester
%rd Folder requester
%%% Percent sign

Start folder
You can choose to start the application/tool either from the active folder window or the destination folder window. If you use the latter option it is important that you use %FN (full path), otherwise the tool won't find the files.

Apply tool on selected files
This tool deals with how any selected files should be treated.

- One at a time - Use this option if you want the tool to open the files one at a time, in series. I.e., the tool will be opened with the first file, and when you close the tool it will open again with the second file and so on.

- All at once (individually) - This will start the tool once for each file in parallel. E.g. if 5 files were selected the tool will be launched 5 times (simultaneously) each with one of the files.

- All at once (as a group) - By using this option the tool will only be started once and given all the files as arguments.

Tip: If your tool does not care about the selected files and you only wish to launch an external application then check the third All at once (as a group) option. Make sure you also select Ignore selection, described below.

Window mode

- Normal - The window opened by the external program is shown in normal state, neither maximized nor minimized.

- Minimized - The window opened is minimized (hidden).

- Maximized - The window opened is maximized, covering the whole screen.

Note: For most "batch" like tools it makes sense to use minimized to make it blend more seamlessly with Magellan Explorer. On tools that require user interaction with the started program you will typically choose normal or maximized.

Options
The following options deal with how files and folders are passed on to the application. Correctly setting these options are vital to getting the desired result from your tool.

- Include sub folders - Checking this option will include selected folders, but not the files inside them (non-recursive). Leaving it unchecked will only include files.

- Ignore selection - This will start the application without any files as argument regardless of whether any were selected. If you did not make use of any of the %f or %F options in the command line then this option should be checked.

- Wrap filenames in quotes - By checking this filenames will be sent to the application in quotes (e.g. "filename.txt"). This may be required when working with files containing spaces, hence it should usually be checked.

### 4.8.3.7 External editors

The **External editors** preferences page is accessed by selecting Options, followed by Preferences and finally Tools and toolbars from the main menu bar. Then click on the External editors tab at the top of the preferences dialog.

Magellan Explorer supports easy editing of different file formats through external editors. The edit tool will launch an editor for the selected file(s). To determine the editor to use, the settings configurable on this page are used.

To configure follow the following steps.

**Step 1:** Select the editor you wish to configure from the drop down menu. You can configure individual editors for text files, images, videos and audio files. You can also configure a hex editor to handle any other format.

**Step 2:** Enter the full path to the editor executable in the Editor location box, or use the browse
button to help locate the editor.

**Step 3**: Add the extensions you wish to associate with this editor. These extensions determine which editor is invoked when you apply the edit tool on a file. An extension may only be associated with a single editor. To add extensions simply enter the extension, e.g. `.txt` in the Extensions box and click the + button. To remove extensions from the list of configured extensions simply select the extension and click the X button.

### 4.8.4 Miscellaneous

The following sections are covered by the Miscellaneous preferences.

- [Search and filter](#)
- [Progress](#)
- [Performance](#)
- [Shell integration](#)
- [Auto update](#)
- [History](#)
- [Miscellaneous](#)

#### 4.8.4.1 Search and filter

The Search and filter preferences page is accessed by selecting Options, followed by Preferences and finally Misc from the main menu bar.

These settings specify the default settings for the Search and Filter dialogs. You can change the settings in the dialogs whenever you use the Search or Filter tools, these are just the default values.

**Default search options**

- Include sub folders - Search inside (recurse) sub folders
- Include hidden files and folders - By default Magellan Explorer will not search these files or folders as they typically belong to the operating system and should not be managed by the user
- Show search dialog in advanced mode by default - The find dialog has both a basic and advanced mode. See the Search and Filter tools section for more information.

**Default filter options**

The filter options are divided into the ones used by the filter dialog and the ones used by the filter box beneath the folder window. See the section on the filter box for more information about how to use that feature.

Filter dialog

- Include sub folders - Include sub folders in filtered folder listings
- Include hidden files and folders - Include hidden files and folders in filtered folder listings.
- Show filter dialog in advanced mode by default - The filter dialog has both a basic and advanced mode. See the Search and Filter tools section for more information.
Filter box
- Include sub folders - Include sub folders in filtered folder listings
- Include hidden files and folders - Include hidden files and folders in filtered folder listings.

Note: The settings for the filter box cannot be overridden anywhere else, they can only be set on this configuration page.

4.8.4.2 Progress
The Progress preferences page is accessed by selecting Options, followed by Preferences and finally Misc from the main menu bar. Then click on the Progress tab at the top of the preferences dialog.

Window behavior
The progress window displays the progress of any ongoing operations. You can read more about it in the Progress Window section.

You can choose how the progress window should appear when initiating a file operation.
- Bring to front - The progress window is opened immediately when a file operation is started. The window appears in the same position it was in the last time it was opened.
- Open minimized - The progress window is opened immediately, but in a minimized state available from the taskbar.
- Do not open - The progress window is never opened automatically.

Tip: You can always open and close the progress window manually from the Window menu.

Progress Information
When the progress window is in Normal or Advanced mode Magellan Explorer can display additional progress information when applicable. This information includes transfer speed (kB per second) and time remaining. You can change the mode of the progress window from within the progress window itself, see the Progress Window section for details.

4.8.4.3 Performance
The Performance preferences page is accessed by selecting Options, followed by Preferences and finally Misc from the main menu bar. Then click on the Performance tab at the top of the preferences dialog.

This configuration page is intended for advanced users only. Changes are not required under normal circumstances.

Background Operations
Concurrent local operations
By increasing this value Magellan Explorer will start more file operations, such as Copy and move, simultaneously, rather than queuing them up.

Normally it is recommended that you leave this option at its default state. If your computer has a high performance storage system, such as multi-disk SCSI system, you can increase it better the overall performance.
Concurrent FTP sessions

By increasing this value Magellan Explorer will start more downloads/uploads simultaneously, rather then queuing them up.

If you are connected to the internet using a modem or ISDN connection it is recommended that you leave this option in its default state. On the other hand, if you are using internet through a fast LAN, DSL or cable connection you may want to increase the number to increase the total performance of your FTP sessions.

**Note:** Please be aware that these options will never increase the performance of individual operations, only on the sum of all operations currently ongoing when there are more than one. The individual operations may perform slower when more concurrency is allowed.

### 4.8.4.4 Shell Integration

The Shell Integration preferences page is accessed by selecting Options, followed by Preferences and finally Misc from the main menu bar. Then click on the Shell Integration tab at the top of the preferences dialog.

**Context menu**

If you would like to open a folder using Magellan Explorer anywhere on your system, you can choose to have it appear on the right-click context menu. You must also have shell integration enabled in order to be able to drag & drop files from archives and FTP sites onto the desktop or onto Windows Explorer.

### 4.8.4.5 Auto update

The Auto update preferences page is accessed by selecting Options, followed by Preferences and finally Misc from the main menu bar. Then click on the Auto update tab at the top of the preferences dialog.

**Checking for updates**

Magellan Explorer is able to check for new versions of itself when connected to the Internet. It does so by downloading a small (4 byte) file over a HTTP connection from www.enriva.com.

**Note:** If you run any firewall software that restricts outgoing connection requests you may have to allow Magellan Explorer as well as the executables meupdate.exe and meupdate1.exe to access the internet (or at least www.enriva.com on port 80). Otherwise this feature will not work.

This is highly recommend as it consumes little bandwidth and saves you from manually checking for updates. Furthermore, the updates can be automatically downloaded and installed by Magellan Explorer. It's so easy there's no reason not to use it.

**Proxy configuration**

Some setups require a proxy to be used to access the internet. You most likely already know if this applies to you. If it does not you can simply skip this configuration. If you are unsure of whether you should use a proxy then first try not using one and check manually for updates from the Help menu. If this reports an error, please consult your system administrator or ISP.

- Connect through a web proxy - Leave uncheck to not use a proxy, checked to use a proxy and in a half-state (square box) to use the same settings as Internet Explorer.
• Host name - This is the host name of the HTTP proxy
• Port - The port on the proxy server where the proxy is located. Usually 3128 or 8080, but other variations exist.
• Authentication - If your proxy requires authentication (basic auth) check this box and enter your user name and password

4.8.4.6 History
The History preferences page is accessed by selecting Options, followed by Preferences and finally Misc from the main menu bar. Then click on the History tab at the top of the preferences dialog.

Magellan Explorer contains several histories to make using it easier. This page allows you to configure the capacity of some of these histories as well as clearing them.

Folder histories
The folder histories remember what folders you have had open recently and provides easy access to these folders through the history tool.

• Global history - Global history accessible from the history tool on the navigation bar (if present)
• Folder window local history - Local per folder window history accessible from the history tool on the quick bar or main toolbar (if present)

Other histories
You may also configure some other histories within Magellan Explorer.

• Search and filter history - This covers the drop down box histories in the search and filter dialogs
• Select and deselect history - This covers the drop down box history in the select and deselect dialogs

4.8.4.7 Miscellaneous
The Miscellaneous preferences page is accessed by selecting Options, followed by Preferences and finally Misc from the main menu bar. Then click on the Miscellaneous tab at the top of the preferences dialog.

Integrated viewer
Open supported image file types in the viewer when double clicked
When checked double clicking an image file will open it in the integrated Magellan Explorer viewer. When left unchecked it will use the Window registry association instead and open the file in whatever application currently associated with it.

Open text files (txt, nfo, diz) in the viewer when double clicked
The same as the option above, except this applies to text files with the extensions .txt, .nfo and .diz.

Tip: You can view any file with the Magellan Explorer viewer no matter what these two options are set to by using the view tool rather than double clicking the file. For more information, see the section on the Integrated Viewer.
Use ActiveX support to view HTML, Office documents and AutoCAD files

Magellan Explorer supports viewing certain types of files natively within the integrated viewer using external ActiveX (COM) components. If you would rather view this as text/hex then uncheck this option. This setting applies only to files opened using the view tool. Files double clicked will always use the registry association.

**Advanced options**

Disable trimming of process working set on minimize

From Microsoft Knowledge Base Article 293215:

> When an application's top-level window is minimized through the Minimize command from its System menu or a click on its Minimize button, the operating system will trim the working set for the process. This is done to free up RAM for foreground applications. As a result of this trimming, a process may experience significantly poorer performance because its memory pages are being faulted back into RAM.

Magellan Explorer can disable this trimming to improve performance when un-minimizing.

Show first level of favorites directly in My Computer folder list

Prior to version 3.0 Magellan Explorer would display the first level of favorites directly in the My Computer list, rather than just the Favorites item as in 3.0 and 3.10. With the introduction of 3.20 this display is again the default. You can turn it off if you preferred it the way it was in 3.0 and 3.10.

### 4.8.5 Folders

The following sections are covered by the Folder preferences.

- **General**
- **Attribute**
- **Advanced**

#### 4.8.5.1 General

The General preferences page is accessed by selecting Options, followed by Preferences and finally Folders from the main menu bar.

**4DOS description support**

Magellan Explorer has the ability to display file comments saved in a file such as 4DOS's descript.ion. This feature can be disabled by clicking on the check box next to it.

If you don't want the file containing the comments to appear in the folder window remove the check mark next to "Display description file".

You can also specify the name of the file containing the file comments.

**Recycle bin**

You can configure whether or not to have Magellan Explorer move files to the recycle bin when they...
are deleted.

- Use Windows setting - If the recycle bin is enabled in Windows Explorer then it will be enabled in Magellan Explorer also
- Never use - Files are never moved to the recycle bin no matter what the Windows Explorer setting

If you have Use Windows setting enabled you may also choose to suppress all confirmation dialogs issued by Windows during deletes. The only confirmations displayed then will be the delete confirmations configurable in the Confirmations section in the User Interface preferences.

**Note**: The recycle bin is not supported inside archives or on FTP sites. Files deleted are never moved to the recycle bin.

**Tip**: Even with the recycle bin turned on you can still bypass it at any time by holding down the **SHIFT** key when pressing the **DELETE** key or the delete tool.

**File protection**

Magellan Explorer can issue warning when you attempt to delete certain files. These file types are:

- Read-Only
- Hidden
- System

**Note**: These warnings can only be issued when the recycle bin is not used, due to the way files are deleted to the recycle bin.

### 4.8.5.2 Attribute

The Attribute preferences page is accessed by selecting Options, followed by Preferences and finally Folders from the main menu bar. Then click on the Attribute tab at the top of the preferences dialog.

**Attributes and timestamps**

You can configure the way Magellan Explorer modifies attributes and timestamps on folders. These options apply to the Attribute and Group Attribute tools. The options available are:

- Ask before setting attributes for files in sub folders
- Always set attributes for files in folders
- Never set attributes for files in sub folders and don't ask

The same options are available for timestamp recursion.

**NTFS compression**

The NTFS file system supports native compression of files and folders. You can make Magellan Explorer always compress/decompress files contained in folders when you modify the compressed attribute of a folder.

If this option is not checked then Magellan Explorer will prompt you each time the Attribute or Group Attribute tool is used to change the compression attribute.
4.8.5.3 **Advanced**

The Advanced preferences page is accessed by selecting Options, followed by Preferences and finally Folders from the main menu bar. Then click on the Advanced tab at the top of the preferences dialog.

This page lets you configure miscellaneous folder settings. For advanced users only.

**Hidden files**

By default Magellan Explorer will display all files, regardless of attribute. If you want to protect your system and hidden files you can check the options and any files with these attributes won't appear in the folder window at all.

Furthermore you can configure other files and folders that should not be shown. This is done by entering the filename or folder name and clicking the + button to add it to the list.

**Miscellaneous options**

You can configure Magellan Explorer to automatically clear the Read-Only attribute when copying files from removable media. This is useful when copying files from e.g CD-ROMs or DVD-ROMs where all files are marked as read only due to the nature of the media being read only.

You can also chose whether to let Magellan Explorer automatically display suitable folders using the shell view (same as Windows Explorer) or not. These folders include the desktop, the fonts folder etc, The default is Enabled.

The last option lets you specify whether or not to attempt loading of icons from within executables etc. located on a network drive when displaying folder contents. If experience slow folder loading on network drives then check this option.

### 4.8.6 FTP

The following sections are covered by the FTP preferences.

- **Defaults**
- **File transfers**
- **Proxy**
- **Advanced**

#### 4.8.6.1 Defaults

The Defaults preferences page is accessed by selecting Options, followed by Preferences and finally FTP from the main menu bar.

This page lets you configure default settings for the FTP component in Magellan Explorer.

**E-Mail**

When connection to a site using Anonymous login it is required that use supply your E-mail address as password.

**Double-click action**

You can specify what type of action should occur when double-clicking on a file placed on a FTP
server. Magellan Explorer can either download the file and start the application associated with the file type or just download the file. In the latter option is chosen then the file will be downloaded to the folder currently open in the target folder window.

**Clipboard URL monitoring**

When you cut and paste text in Windows they are stored in the clipboard. Magellan Explorer can monitor the clipboard after any lines that start with ftp://, indicating that it is a ftp address. Once an FTP address (URL) is encountered you can choose to have any of the following actions taken.

- Automatically connect to the site - Magellan Explorer will attempt to connect and login without first prompting you with the Quick Connect dialog.
- Open the Quick Connect dialog with the site address - Same as above, except the Quick Connect dialog will be opened first and you will be able to abort the connect here.
- Do not monitor the clipboard - Effectively disables this feature.

**Note:** The currently active folder window will be used when connecting to the FTP server.

### 4.8.6.2 File transfers

The **File transfers** preferences page is accessed by selecting Options, followed by Preferences and finally FTP from the main menu bar. Then click on the File transfers tab at the top of the preferences dialog.

This tab contains options to fine-tune the FTP sessions. If you are new to the world of FTP it is recommended that you leave all the options in their default state.

**ASCII file types**

There are two different ways of transferring files from (or to) a FTP site. These are called binary and ASCII. As general rule it is always wise to use binary when transferring data files and ASCII when transferring text files. The ASCII transfer mode will convert Windows text files that use CRLF as line breaks to their UNIX equivalents with LF line breaks (assuming the server runs on a UNIX platform).

You can configure the which extensions should be transferred as ASCII on this page.

To add an extension enter it in the edit box, e.g. `.txt` without using any wild cards and then click Add. You may remove any of the extensions by selecting it in the list and clicking on Remove.

**Miscellaneous**

**Transfer types**

You can either set the transfer type to auto detect and let Magellan Explorer switch between ASCII and binary modes based on the file extensions as configured above, or you can chose to always use binary.

**Filename case conversion**

Unlike the Windows file systems, the file systems on UNIX ftp servers are usually case sensitive. This means that `text.txt` and `Text.txt` are two different files. If you would like Magellan Explorer to force the case of any files you upload to a particular format you can choose so here. The available options are.
4.8.6.3 Proxy

The Proxy preferences page is accessed by selecting Options, followed by Preferences and finally FTP from the main menu bar. Then click on the Proxy tab at the top of the preferences dialog.

Proxy server

If your network has an FTP proxy server you may need to use it when connecting to FTP sites with Magellan Explorer. If you are unsure whether this applies to you then ask your system administrator for details.

Magellan Explorer supports both unauthenticated and authenticated SOCKS4/5 proxies. Select the mode of your proxy and enter the details in the text boxes on the right.

Connection type

In passive mode (default) Magellan Explorer will initiate file transfers to and from the FTP server by connecting to the server and not the other way around. This is useful if you are situated behind a firewall and cannot accept incoming connections.

Non-passive means that the server connects to you.

4.8.6.4 Advanced

The Proxy preferences page is accessed by selecting Options, followed by Preferences and finally FTP from the main menu bar. Then click on the Proxy tab at the top of the preferences dialog.

This page provides you with the ability to tune several advanced FTP options within Magellan Explorer. For advanced users only.

Miscellaneous

Opens FTP information window when I connect

The FTP information window contains a log of all commands sent to and from the server. This option opens the window automatically each time you connect to an FTP site.

Close FTP information window when I disconnect

This option closes the window automatically each time you disconnect to an FTP site.

Add the files i download to the downloaded files to the Recent Documents menu in the Start Menu

The Recent Documents menu is located on the Start button. Please note that only files with registered file types/extensions will be added.

Always show hidden files (files that begin with a '.')

On UNIX FTP servers it is common that files beginning with a period are hidden and should not be displayed in normal folder listings. This option controls whether hidden files are shown on FTP sites.
Keep connection alive

Normally you will get disconnected from an FTP server if you do not perform any commands over a fixed period of time. By checking this option Magellan Explorer will keep the connection active by sending a PWD command to the server every 90 seconds.

Please note that this is may be unpopular on some FTP servers. If you use this feature it is recommended that you read through the Welcome Message every time you connect to a new site to see if they have a policy on this area.

You may turn this option of for the active session in the FTP menu after connecting.

Show message of the day (MOTD) in a window after login

Some servers will send a welcome message, also known as the message of the day, when you log in. This will always be output in the FTP information window, however you may also choose to have the message displayed in a separate pop up window after login.

Preserve date & time on transferred files when supported by the server

The original FTP specification did not support any means of preserving the date & time on files either uploaded to or downloaded from the server. However, there have been extensions to the format and a command known as MDTM supports retrieving this information from the server and on some servers also setting the information on uploaded files. Magellan Explorer can attempt to make use of this command when supported by the server.

Connect retries

If you for some reason are unable to connect to a site (it is busy etc) Magellan Explorer may try to connect again either a fixed number of times or infinitely. You may also specify how long it should wait before trying again.

Please note that setting the delay to a low value and the number of retries to a high number or infinitely (also called hammering) is not considered to be "good nettiquette" and may provoke a reaction from the FTP site maintainer.

4.8.7 Archive

The following sections are covered by the Archive preferences.

- General
- Zip
- Ace
- Rar
- Ari and Lha
- Cab and Unix formats
4.8.7.1 General

The General preferences page is accessed by selecting Options, followed by Preferences and finally Archive from the main menu bar.

This page lets you associate Magellan Explorer with different archive types. When you do this you will be able to double click the archive from outside of Magellan Explorer and have it launch automatically and open the archive.

It is recommended that you check all the options if you have no other archive management software installed. If, on the other hand, you have another archive management application installed you may wish to leave certain file types associated with that application.

No matter what selections you use here you will still be able to open archives internally inside Magellan Explorer.

4.8.7.2 Zip

The Zip preferences page is accessed by selecting Options, followed by Preferences and finally Archive from the main menu bar. Then click on the Zip tab at the top of the preferences dialog.

Internal UnZip

If you have already installed an archive manager and wish to continue using it set this option to Use registry association.

Compression level

This is tradeoff between speed and size. If you set the compression level to none or a low value the zip operation will be faster, but the archive size bigger. The scale goes from 0 to 9, where 6 is the default value.

Misc

Always install when double clicking Install.exe or Setup.exe

Today many applications are distributed in a Zip archive. The install feature makes it easy to setup such programs on your system by automatically extracting the archive to a temporary folder and starting the installer.

Default compression method

Magellan Explorer supports several Zip compression algorithms. The default algorithm to use can be configured on this page, but you can always change to a different algorithm in the New Archive dialog available from the archive menu.

- Deflate - Deflate is the compression algorithm used by the PKZIP 2.04g file format. This algorithm has pretty good compression and is quite fast. It is the default compression algorithm used by Magellan Explorer.
- Deflate64 - The Deflate64™, also know as Enhanced Deflate, compression algorithm is a variation of the Deflate algorithm that uses a 64K sliding window rather than a 32K window in order to compress a sequence of bits. Deflate64™ takes longer to compress data than Deflate, however it provides better compression. In comparison to BWT, Deflate64™ is slightly faster but does not compress as well.
• Burrows Wheeler - The BWT compression method is an implementation of the Burrows-Wheeler Transform compression algorithm with Huffman encoding. It was popularized by the UNIX and Linux BZip2 program. It offers significantly better compression than Deflate but takes longer to compress and decompress data.

• Store - Uses no compression.

**Note:** The Deflate64™ and Burrows Wheeler (BWT) algorithms create archives that may not be supported by all compression programs.

Deflate64™ is a trademark of PKWARE Inc.

### 4.8.7.3 Ace

The Ace preferences page is accessed by selecting Options, followed by Preferences and finally Archive from the main menu bar. Then click on the Ace tab at the top of the preferences dialog.

**Internal UnAce**

Just as Zip archives you can open Ace files as folders. If you wish to continue using your former application set this options to Use registry association.

**Compression level**

This is tradeoff between speed and size. If you set the compression level to none or a low value the operation will be faster, but the archive size bigger. The scale goes from 0 to 5, where 3 is the default value.

**Archiver**

If you have ace.exe installed Magellan Explorer can use it to add files to existing archives and make new ones. The Search button will automatically search all resources for the correct files.

**Note:** Please note that ace.exe is an independent application and need to be registered according to the license information if used beyond its evaluation period.

**Show command line**

You can choose whether you like the command line output to be displayed while adding or deleting files from an archive.

**Modified time and date**

You may specify which date Magellan Explorer should set on the archive when adding files.

**Miscellaneous**

Always install when double clicking Install.exe or Setup.exe

Today many applications are distributed in a Ace archive. The install feature makes it easy to setup such programs on your system by automatically extracting the archive to a temporary folder and starting the installer.

**Default compression method**

• Solid - This mode causes the Ace archiver to merge all files in the archive to archive a better
compression ratio. However, this will slow down the decompression and subsequent updates to the archive.

- Normal - Each file in the archive is compressed separately. This achieves slightly lower compression ratios, but offers better extraction and update performance.

Please consult the Ace documentation for more details.

4.8.7.4 Rar

The Rar preferences page is accessed by selecting Options, followed by Preferences and finally Archive from the main menu bar. Then click on the Rar tab at the top of the preferences dialog.

Internal UnRar

Just as Zip archives you can open Rar files as folders. If you wish to continue using your former application set this options to Use registry association.

Compression level

This is tradeoff between speed and size. If you set the compression level to none or a low value the operation will be faster, but the archive size bigger. The scale goes from 0 to 5, where 3 is the default value.

Archiver

If you have rar.exe installed Magellan Explorer can use it to add files to existing archives and make new ones. The Search button will automatically search all resources for the correct files.

Note: Please note that rar.exe is an independent application and need to be registered according to the license information if used beyond its evaluation period.

Show command line

You can choose wether you like the command line output to be displayed while adding or deleting files from an archive.

Modified time an date

You may specify which date Magellan Explorer should set on the archive when adding files.

Miscellaneous

Always install when double clicking Install.exe or Setup.exe

Today many applications are distributed in a Rar archive. The install feature makes it easy to setup such programs on your system by automatically extracting the archive to a temporary folder and starting the installer.

Default compression method

- Solid - This mode causes the Rar archiver to merge all files in the archive to archive a better compression ratio. However, this will slow down the decompression and subsequent updates to the archive.

- Multimedia - Use a compression method specifically geared towards compression multimedia content such as image, video and audio files.
Solid+MM - Use a combination of solid and multimedia compression methods.

Normal - Each file in the archive is compressed separately. This achieves slightly lower compression ratios, but offers better extraction and update performance.

Please consult the Rar documentation for more details.

### 4.8.7.5 Arj and Lha

The Arj and Lha preferences page is accessed by selecting Options, followed by Preferences and finally Archive from the main menu bar. Then click on the Arj and Lha tab at the top of the preferences dialog.

**Internal UnArj**

If you have already installed an archive manager and wish to continue using it set this option to Use registry association.

Always install when double clicking Install.exe or Setup.exe

Some applications may be distributed inside an Arj archive. The install feature makes it easy to setup such programs on your system by automatically extracting the archive to a temporary folder and starting the installer.

**Internal UnLha**

If you have already installed an archive manager and wish to continue using it set this option to Use registry association.

Always install when double clicking Install.exe or Setup.exe

Some applications may be distributed inside an Lha archive. The install feature makes it easy to setup such programs on your system by automatically extracting the archive to a temporary folder and starting the installer.

### 4.8.7.6 Cab and Unix formats

The Cab and Unix formats preferences page is accessed by selecting Options, followed by Preferences and finally Archive from the main menu bar. Then click on the Cab and Unix formats tab at the top of the preferences dialog.

**Internal Uncab**

If you have already installed an archive manager and wish to continue using it set this option to Use registry association.

Always install when double clicking Install.exe or Setup.exe

Some applications may be distributed inside a Cab archive. The install feature makes it easy to setup such programs on your system by automatically extracting the archive to a temporary folder and starting the installer.

**Internal support for UNIX archive formats**

The following UNIX archive formats are supported: Tar, Rpm, Cpio, Compress (Z), GZip and BZip2. If
you have already installed an archive manager that handle these and wish to continue using it set this option to Use registry association.

Always install when double clicking Install.exe or Setup.exe
Some applications may be distributed inside a UNIX archive. The install feature makes it easy to setup such programs on your system by automatically extracting the archive to a temporary folder and starting the installer.

Default compression method
You can specify the default compression method used when creating Tar archives.

- GZip - Use GZip compression to generate a .tar.gz or .tgz archive
- BZip2 - Use BZip2 compression to generate a .tar.bz2 archive
- None - Use no compression to generate a normal .tar archive
Part V
5  Order Information

Order Overview
You may order Magellan Explorer using a wide range of payment methods. Please click on the country closest to yourself to get information on how to place an order.

Full (licensed) version
When you purchase a license you can download the full version. This version can be used for an unlimited period of time and will not display the Evaluation notice on startup. The name of the license owner will also appear in the About box. In addition there are several bonus features available in the full version.

Click here to learn about the bonus features!

Pricing information
A single user license can be purchased for only $39.95.
You can also purchase multiple licenses and the following quantity discounts are available.

<table>
<thead>
<tr>
<th>License Type</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single user license</td>
<td>$39.95</td>
</tr>
<tr>
<td>5 user license</td>
<td>$160.00</td>
</tr>
<tr>
<td>10 user license</td>
<td>$280.00</td>
</tr>
<tr>
<td>25 user license</td>
<td>$600.00</td>
</tr>
</tbody>
</table>

All prices are in USD.
To purchase more than 25 licenses or a site license, please send an inquiry to sales@enriva.com. If you don't have access to e-mail ask your local reseller to get a quote.

Upgrade information
Please click [here](#) if you already own a v1.x or v2.x copy.

Purchase information
- Online Ordering
- Phone/Fax
- Cash
- Money Orders / Checks

List of international resellers

North America
- United States

Oceania/Asia
- Australia
Europe
- Belgium
- Denmark
- Finland
- France
- Germany
- Italy
- The Netherlands
- Norway
- Sweden
- United Kingdom

5.1 Upgrade from a previous version

All updates to your copy of the full version are free. An update is a small or medium release and usually contain fixes and sometimes new features. E.g., if you bought v1.0 you were entitled to update your copy of Voyager with 1.01, 1.02, 1.1, 1.5 and 1.6. Going along the same line, if you purchase a license for v3.0 it will give you access to all subsequent v3.x releases for free.

Upgrades on the other hand must be purchased. They are major new versions, symbolized by the change of the first digit in the version number, and contains a range of new features. E.g. if you have bought any of the v1.x or v2.x releases you need to purchase an upgrade to v3.0.

<table>
<thead>
<tr>
<th>License Type</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single User License</td>
<td>$19.95</td>
</tr>
<tr>
<td>5 User License</td>
<td>$80.00</td>
</tr>
<tr>
<td>10 User License</td>
<td>$140.00</td>
</tr>
<tr>
<td>25 User License</td>
<td>$300.00</td>
</tr>
</tbody>
</table>

All prices are in USD.

Purchase information can be found on [here](#).

5.2 Bonus features

The bonus features are only available in the licensed version of Magellan Explorer.

- Greatly enhanced favorites support. You can have an unlimited number of favorites and create sub folders to categorize them into groups. Management is easy using drag & drop.

- Ability to minimize Magellan Explorer to the system tray. Use the taskbar, tray or both to display the application icon.

- Up to ten simultaneous FTP connections. Stop single-tasking your FTP sessions, have several sites opened at the same time! You can quickly switch between them from the list in the FTP menu.

- Keep your FTP connections from disconnecting when they're idle using the Keep Alive feature.
• Up to 100 Custom Tools. Harness the power of your existing utilities by integrating them into the Magellan Explorer interface.

• Export and import your configuration to easily backup your settings

Click here to get more information on how to purchase a full version license.

5.3 Online Ordering

Online ordering
If you have an internet connection it is recommended that you stop by our order page for the most up to date information. You can also find the price of an upgrade from v2.x to v3.0 and order form to use. Please go to: http://www.enriva.com

Online Order forms
http://www.enriva.com/MagellanExplorer/Order/credit_cards.html

5.4 Phone/Fax

If you don't want to order over the Internet you can purchase Magellan Explorer directly from our publisher, BMT Micro Inc.

They accept American Express, Carte Blanche, Diner's Club, Discover, Euro card, MasterCard, Novus (All variations), Optima and Visa.

Phone
To order by phone, please call one of the number below between 8:00am and 7:00pm EST (-5 GMT).

Sales   (800) 414-4268
Phone   (910) 791-7052

Fax/Mail
You may fax or mail your credit card information. Please complete and include the order form, and fax it or send it to the number/address below.

Fax     (910) 350-2937
        (800)-346-1672

Contact Information
BMT Micro
5019 Carolina Beach Road, Suite 202
Wilmington, NC 28412,
USA

5.5 Cash

If you don't want to order over the Internet you can purchase Magellan Explorer directly from our publisher, BMT Micro Inc.

Cash / Non-USA Funds
We do not encourage that you send cash or currency in the mail but if you choose this method we will only be responsible for delivery if the mail containing your registration and cash require a signature upon receipt of delivery by a BMT Micro employee.

We gladly accept Euro and British currency in any amount. Euro checks are welcome but must be made in Euro.

Contact Information
BMT Micro
5019 Carolina Beach Road, Suite 202
Wilmington, NC 28412
USA
Email  orders@bmtmicro.com
Website  http://www.bmtmicro.com
Sales  (800) 414-4268
Phone  (910) 792-9100
Fax  (800)-346-1672
(910) 792-1889

5.6  Money Orders / Checks
If you don't want to order over the Internet you can purchase Magellan Explorer directly from our publisher, BMT Micro Inc.

Money Orders / Cashiers Checks
Money orders, cashiers checks, and bank drafts are welcome, and all software purchased using these methods will ship as soon as payment is received. Please remember that all payments should be in U.S. dollars unless arrangements are made in advance.

Personal Checks (US or Canadian Funds)
Personal checks are welcome, but please allow up to two weeks for your check to clear the bank. Canadian Funds must equal the registration amount in US dollars.

Make all checks payable to "BMT MICRO" and write "FOR DEPOSIT ONLY" on the reverse side of the check where it will be endorsed for your protection. In the lower-left edge of your check, please write in the name of the program you are registering.

Contact Information
BMT Micro
5019 Carolina Beach Road, Suite 202
Wilmington, NC 28412
USA
5.7 International resellers

Magellan Explorer can also be purchased from our extensive network of resellers. We have resellers in the following countries.

North America
- United States

Oceania/Asia
- Australia

Europe
- Belgium
- Denmark
- Finland
- France
- Germany
- Italy
- The Netherlands
- Norway
- Sweden
- United Kingdom

5.7.1 Australia

You can purchase Magellan Explorer directly from our Australian publisher, Aquarian Technologies. The price is AUD $60.50, which includes S&H.

Dial 1800-240-774 today!

They accept the following payment methods;

- Visa, MasterCard, Bank Card, American Express
- Cheque drawn on an Australian Bank
- Postal Money Order
- Purchase Order (from approved organizations)
• Cash or Bank Transfer.

Inquirers you may have regarding your order should be sent to sales@aquatee.com. You can find the order form by clicking on the link or open the file Orderform-Australia.txt located in your Magellan Explorer folder.

**Contact Information**

**Aquarian Technologies**
P.O. Box 820
Castlemaine VIC, 3450
Australia

- Email: sales@aquatee.com
- Website: [http://www.aquatee.com](http://www.aquatee.com)
- Sales: 1800-240-774
- Phone: (03) 5475-1555
- Fax: (03) 5475-1888

### 5.7.2 Belgium

If you would like to order online, or by using a direct bank transfer, cash, cheque or deposit cheques (all in Euro) contact BTSoftware. You can do so by either visiting their website, or sending a fax, e-mail or letter.

For postal orders, make sure your order contains the name of the user it should be licensed to (normally yourself), your e-mail or postal address, the country in which the payment will be made and of course the name of our product, "Magellan Explorer". You can find the order form by clicking on the link or open the file Orderform-BT.txt located in your Magellan Explorer folder.

**Contact Information**

**BTSoftware**
De Pinckart 54
5674 CC Nuenen
The Netherlands

- Email: order@btsoftware.com
- Website: [http://www.btsoftware.com](http://www.btsoftware.com)
- Phone: +31 (0) 40 2631259
- Fax: +31 (0) 40 2906460

**Important:** If you are connected to the Internet it is recommended that you go to [http://www.enriva.com/MagellanExplorer/Order/](http://www.enriva.com/MagellanExplorer/Order/) and read the order details there.
5.7.3 **Denmark**

**Non-Credit card Orders**

You can order Magellan Explorer directly from our reseller. Use the numbers or addresses listed below to contact them.

Payments are accepted in Danish kroner by cheque drawn on a Danish Bank, Money transfer to Bank account 5211 2651101 (SWIFT-code AMB The prices include 25% tax).

Money transfer from outside Denmark, please add DKK 50,- to cover the fee of the Danish bank.

**Contact Information**

Berggreen Service v/Knud Berggreen
Lodsgården A 111
DK-2791 Dragør
Denmark

Email [info@berggreen.dk](mailto:info@berggreen.dk)

Website [http://www.berggren.dk](http://www.berggren.dk)

Phone +45 3253 7654

Fax +45 3253 7654

**Important:** If you are connected to the Internet it is strongly recommended that you go to [http://www.enriva.com/MagellanExplorer/Order/](http://www.enriva.com/MagellanExplorer/Order/) and read the order details there.

5.7.4 **Finland**

**Non-Credit card Orders**

You can order Magellan Explorer directly from our reseller. Use the numbers or addresses listed below to contact them.

Payments are accepted by cheque in Euro drawn on a Finnish Bank or to Giro account 800059-1088759 in Helsinki. The prices include 25% tax.

**Contact Information**

Berggreen Service v/Knud Berggreen
Lodsgården A 111
DK-2791 Dragør
Denmark

Email [info@berggreen.dk](mailto:info@berggreen.dk)

Website [http://www.berggren.dk](http://www.berggren.dk)

Phone +45 3253 7654

Fax +45 3253 7654

**Important:** If you are connected to the Internet it is strongly recommended that you go to [http://www.enriva.com/MagellanExplorer/Order/](http://www.enriva.com/MagellanExplorer/Order/) and read the order details there.
5.7.5  France

If you would like to order online, or by using a direct bank transfer, cash, cheque or deposit cheques (all in Euro) contact BTSoftware. You can do so by either visiting their website, or sending a fax, e-mail or letter.

For postal orders, make sure your order contains the name of the user it should be licensed to (normally yourself), your e-mail or postal address, the country in which the payment will be made and of course the name of our product, "Magellan Explorer". You can find the order form by clicking on the link or open the file Orderform-BT.txt located in your Magellan Explorer folder.

Contact Information

BTSoftware
De Pinckart 54
5674 CC Nuenen
The Netherlands

Email           order@btsoftware.com
Website         http://www.btsoftware.com

Phone           +31 (0) 40 2631259
Fax             +31 (0) 40 2906460

Important: If you are connected to the Internet it is recommended that you go to http://www.enriva.com/MagellanExplorer/Order/ and read the order details there.

5.7.6  Germany

Phone/Fax

You can order using credit cards. Call, fax or mail your order details to Deckarm & Co using the addresses or numbers listed below.

Contact Information

Deckarm & Co
Maxplatz 10
66386 St Ingbert
Germany

Email           info@softwareshop.com
Website         http://www.softwareshop.com

Phone           +49 68 94/92 93 0
Fax             +49 68 94/92 93 94

Online orders/Bank transfers/Checks/Etc

If you would like to order online, or by using a direct bank transfer, cash, cheque or deposit cheques (all in Euro) contact BTSoftware. You can do so by either visiting their website, or sending a fax, e-mail or letter.

For postal orders, make sure your order contains the name of the user it should be licensed to
(normally yourself), your e-mail or postal address, the country in which the payment will be made and of course the name of our product, "Magellan Explorer". You can find the order form by clicking on the link or open the file Orderform-BT.txt located in your Magellan Explorer folder.

**Account Information**
Generale Bank Germany  
Postfach 101615  
D-41016, Mönchengladbach  
Account Number: 3-3056512-95  
BankLeitZahl : 370 10 600

**Contact Information**
BTSoftware  
De Pinckart 54  
5674 CC Nuenen  
The Netherlands  
Email order@btsoftware.com  
Website http://www.btsoftware.com  
Phone +31 (0) 40 2631259  
Fax +31 (0) 40 2906460

**Important**: If you are connected to the Internet it is recommended that you go to http://www.enriva.com/MagellanExplorer/Order/ and read the order details there.

### 5.7.7 Italy

You can order Magellan Explorer directly from our reseller. Use the number or the addresses listed below to contact them (they accept all major credit cards).

**Contact Information**
Ososoft  
Via Prospero Fontana  
16-40135 Bologna  
Italy  
Email staff@ososoft.com  
Phone 39-51-6151233  
Fax 39-51-6149753

**Important**: If you are connected to the Internet it is recommended that you go to http://www.enriva.com/MagellanExplorer/Order/ and read the order details there.

### 5.7.8 The Netherlands

**Phone/Fax**
You can order using credit cards. Call, fax or mail your order details to Mensys using the addresses or numbers listed below.
Contact Information

Mensys
Crayenestersingel 65
2012 PG Haarlem
The Netherlands

Email mensys@euronet.nl

Phone 31-(0)23-548-2020
Fax 31-(0)23-548-2030

Online orders/Bank transfers/Checks/Etc

If you would like to order online, or by using a direct bank transfer, cash, cheque or deposit cheques (all in Euro) contact BTSoftware. You can do so by either visiting their website, or sending a fax, e-mail or letter.

For postal orders, make sure your order contains the name of the user it should be licensed to (normally yourself), your e-mail or postal address, the country in which the payment will be made and of course the name of our product, "Magellan Explorer". You can find the order form by clicking on the link or open the file Orderform-BT.txt located in your Magellan Explorer folder.

Contact Information

BTSoftware
De Pinckart 54
5674 CC Nuenen
The Netherlands

Email order@btsoftware.com
Website http://www.btsoftware.com

Phone +31 (0) 40 2631259
Fax +31 (0) 40 2906460

Important: If you are connected to the Internet it is recommended that you go to http://www.enriva.com/MagellanExplorer/Order/ and read the order details there.

5.7.9 Norway

Non-Credit card Orders

You can order Magellan Explorer directly from our reseller. Use the numbers or addresses listed below to contact them.

Payments are accepted by cheque in Norwegian kroner drawn on a Norwegian Bank or to Giro account 0806 1908510 in Oslo.

Contact Information

Berggreen Service v/Knud Berggreen
Lodsgården A 111
DK-2791 Dragør
Denmark
Important: If you are connected to the Internet it is strongly recommended that you go to [http://www.enriva.com/MagellanExplorer/Order/](http://www.enriva.com/MagellanExplorer/Order/) and read the order details there.

### 5.7.10 Sweden

**Non-Credit card Orders**

You can order Magellan Explorer directly from our reseller. Use the numbers or addresses listed below to contact them.

Payments are accepted in Swedish kroner by cheque drawn on a Swedish Bank or to Giro account 190 44 64-3 in Stockholm.

**Contact Information**

Berggreen Service v/Knud Berggreen
Lodsgården A 111
DK-2791 Dragør
Denmark

Email: info@berggreen.dk
Website: [http://www.berggren.dk](http://www.berggren.dk)
Phone: +45 3253 7654
Fax: +45 3253 7654

Important: If you are connected to the Internet it is strongly recommended that you go to [http://www.enriva.com/MagellanExplorer/Order/](http://www.enriva.com/MagellanExplorer/Order/) and read the order details there.

### 5.7.11 United Kingdom

If you would like to order online, or by using a direct bank transfer, cash, cheque or deposit cheques (all in UK pounds) contact BTSoftware. You can do so by either visiting their website, or sending a fax, e-mail or letter.

For postal orders, make sure your order contains the name of the user it should be licensed to (normally yourself), your e-mail or postal address, the country in which the payment will be made and of course the name of our product, "Magellan Explorer". You can find the order form by clicking on the link or open the file Orderform-BT.txt located in your Magellan Explorer folder.

**Contact Information**

BTSoftware
De Pinckart 54
5674 CC Nuenen
The Netherlands
Important: If you are connected to the Internet it is recommended that you go to [http://www.enriva.com/MagellanExplorer/Order/](http://www.enriva.com/MagellanExplorer/Order/) and read the order details there.

### 5.7.12 United States

You can purchase Magellan Explorer directly from our publisher in the US, BMT Micro. They accept orders online or by phone, fax and postal mail.

**Dial (800) 414 4268 today!**

The fastest and most convenient way is to use their secure online order forms. Go to our order page at [http://www.enriva.com/MagellanExplorer/Order/](http://www.enriva.com/MagellanExplorer/Order/) and click on "Magellan Explorer" under Order Online.

If you don't want to order over the net or using credit cards you can contact them for further instructions, or send them the normal order form using fax or postal mail. You can find the regular order form by clicking on this link or open the file called Orderform-US.html located in your Magellan Explorer folder.

**Contact Information**

BMT Micro  
5019 Carolina Beach Road, Suite 202  
Wilmington, NC 28412  
USA  

Email orders@bmtmicro.com  
Website [http://www.bmtmicro.com](http://www.bmtmicro.com)  
Sales (800) 414-4268  
Phone (910) 792-9100  
Fax (800)-346-1672  
(910) 792-1889

### 5.8 Order forms

This section contains order forms for America, European and Australia orders.

#### 5.8.1 Order form - Aquarian

Magellan Explorer Order Form  
Australia - Aquarian Technologies  
PO Box 820, Castlemaine, VIC, 3450  
Sales: 1800-240-774, Fax: (03) 5475-1888

Please use this form when ordering by fax or mail:
Name _____________________________________________
Company _____________________________________________
Address _____________________________________________
_____________________________________________
City/Town _____________________________________________
Country _______________________   Post Code _________
Telephone ________________________________
EMail ________________________________

[ ] Cheque   [ ] AMEX   [ ] Money Order
[ ] BankCard   [ ] VISA   [ ] MasterCard

Name on Card _______________________________________
(Only if different from Name above)

Credit Card Number: ________________________________
Expiration Date:   _____ /_____
Signature: ________________________________
EMail Address: ________________________________

___ Copies of Magellan Explorer on CD @ $AUD 77.00 = $_______
___ Copies of Magellan Explorer email @ $AUD 66.00 = $_______

Where did you hear about Magellan Explorer?
_______________________________________________________

Please make cheques payable to: Aquarian Technologies.

5.8.2 Order form - BT Software

Magellan Explorer Order Form

BTSoftware
European Software Registration and Distribution Service

Registration, via BTSoftware, may be arranged by one of
the following methods:

1. Visit BTSoftware at www.BTSoftware.com and fill in the
order form. BTSoftware will send you an order confirmation
with banking details.

2. E-mail BTSoftware at order@BTSoftware.com and we will
mail you the information required to order the software.

3. Fax or mail this form to the address below and we will
send you an order confirmation form with our banking details
for your country.
Payments can be done by Credit Card or local banktransfer.

Enriva Magellan Explorer Order Form

| License Name: | -------------------------------------------------------------- |
| Name: | -------------------------------------------------------------- |
| Company: | -------------------------------------------------------------- |
| Vat Number: | -------------------------------------------------------------- |
| Street: | -------------------------------------------------------------- |
| City: | Postal Code: |
| Country: | |
| Email: | |

<table>
<thead>
<tr>
<th>Unit Price</th>
<th>Quantity</th>
<th>Sub Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Magellan Explorer</td>
<td>$39.95</td>
<td>X</td>
</tr>
<tr>
<td>VAT (BTW/MSTW)19.0%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

You will be sent an order confirmation in your local currency.

Post to:

BTSoftware BV  
De Pinckart 54  
5674 CC Nuenen  
The Netherlands

Phone: +31 (0) 40 2631259  
Fax: +31 (0) 40 2906460

At present, BTSoftware has bank accounts in The Netherlands, Belgium, France, Germany, Austria, Italy, Luxembourg and The United Kingdom. Low-cost EUR bankpayments are supported from all European countries.

Thank you for registering.

BTSoftware  
The Netherlands

E-mail: order@BTSoftware.com  
Site: http://www.btsoftware.com

5.8.3 Order form - BMT Micro
6 Support

This section will try to answer any support questions you have, or help point you in the right direction.

6.1 Frequently asked questions

This section will answer some frequently asked questions and provide hints & tips to using Magellan Explorer.

6.1.1 Installation and configuration

This section contains useful information about installing Magellan Explorer, as well as information related to configuring Magellan Explorer. This FAQ is also available on our web site.

1. Magellan Explorer doesn't display a particular file, what do I do?

Microsoft Windows may hide certain files determined to belong to the operating system. To make sure these are displayed you must uncheck the "Hide protected operating system files" in the Windows Explorer Folder Options dialog (on the View tab).

Furthermore, certain settings within Magellan Explorer may hide files. These settings are available in the Folder preferences from within Magellan Explorer on the Advanced tab.

2. I am using the right mouse button to select files, how do I display context menus?

Hold down the right mouse button for approximately one second and the context menu will be shown.

3. How do I change the file selection method to be similar to Windows Explorer?

Open the User Interface preferences from the Options menu and go to the Selection section. The buttons Normal, Commander and Explorer allows for easy switching of selection mode. You can also select the list view mode you prefer, but keep in mind that this affects other selection settings.

4. How do I chose which columns are shown?

Click with the right mouse button on the columns and uncheck the columns you do not wish to show from the popup menu. That changes temporarily for the current folder.

To permanently save it for either just the current folder (or folder branch) or all folders select "Customize folder" from the view menu. Make sure "remember column layout" is checked, select where the settings should apply and click OK.

5. How do I change the placement of the main toolbar?

From the View menu select Toolbars followed by Toolbar. This will let you select the placement of the main toolbar.

6. Changing background colors on toolbars does not work

Magellan Explorer 3.0 uses Windows XP theme functionality (if enabled) to draw the toolbars. This means that you cannot configure the background colors of the main toolbar, navigation bar, quick bar or drive bar in the preferences unless you use the Windows Classic theme.
7. How do I change the file selection method to be similar to Windows Explorer?

Open the User Interface preferences from the Options menu and go to the Selection section. The buttons Normal, Commander and Explorer allows for easy switching of selection mode. You can also select the list view mode you prefer, but keep in mind that this affects other selection settings.

8. How can I add New buttons to the Button Panel

You can add new buttons to the Button Panel from the "Tools and Toolbars" section of the preferences.

First, adjust the size of the Button Panel by clicking on the Appearance button. Then click on Add/Remove. You can now add tools to buttons by first clicking on a button and then selecting a tool from the list on the left and clicking Add to Button.

When you are finished click OK to save.

9. How do I add a custom tool to the button panel?

You can add a custom tool that you have created to the button panel by following these steps:

1. Go to Tools and Toolbars|Button Panel in the preferences
2. Choose a button where you wish to add the custom tool
3. Select your custom tool from the tools list
4. Click the "Add to button" button.

10. Can Magellan Explorer be configured to show filenames without extension?

No, this cannot be configured.

11. Can the Folder Windows be tiled horizontally?

Yes! From the Window menu choose "Top-bottom windows" from either the "Dual Windows" or "Dual Explorer" sub menu depending on whether you wish to use Explorer mode or not.

12. Is Magellan Explorer compatible with Windows XP Service Pack 2?

Magellan Explorer 3.0 has been tested successfully with the Service Pack 2 Preview Release on Windows XP.

13. Is Magellan Explorer Windows XP compatible?

Yes, version 2.53 and later is compatible with Windows XP. Earlier versions may not work properly.

14. How do I create 4 drive window panes?

You can currently only have two window panes (or folder windows as we call them).

15. Is Magellan Explorer Windows ME compatible?

Yes, Magellan Explorer has been tested on Windows ME (Millenium Edition) and there should be no incompatibilities.


Yes, we have tested Magellan Explorer extensively on Windows 2000 Professional and there should be no incompatibilities.
17. Can I move the PathBox to the top of the folder window?
No, you cannot currently configure the location of the PathBox or turn it off.

18. Can I turn off the LabelBox?
No, the LabelBox cannot be turned off as it is essential in showing which folder window is the active, as well as showing the label and free disk space for that folder window.

19. How do I export my configuration settings?
Exporting and importing Magellan Explorer configuration settings can be performed using the Import and Export menu options on the Options|Preferences menu.

20. Upgrading my purchased copy turns it into an evaluation version
Upgrades from Magellan Explorer 2.x to 3.0 require the purchase of an upgrade which is currently available for $19.95 from our order page.

After ordering you will receive your personal key shortly and should be up and running in no time.

6.1.2 General usage

This section answers questions related to the general use of Magellan Explorer. This FAQ is also available on our web site.

1. How do I use the slide show feature?
Select the files you wish to view (or only a single file) and open the viewer. Then press PgDn/PgUp (or select Next/Prev from the file menu) to flip through the selected images or all images in the current folder if only one image was selected.

2. Magellan Explorer doesn't display a particular file, what do I do?
Microsoft Windows may hide certain files determined to belong to the operating system. To make sure these are displayed you must uncheck the "Hide protected operating system files" in the Windows Explorer Folder Options dialog (on the View tab).

Furthermore, certain settings within Magellan Explorer may hide files. These settings are available in the Folder preferences from within Magellan Explorer on the Advanced tab.

3. How can I view the contents of a self extracting ZIP archive?
Right click on the executable in the folder window and select Open Executable As ZIP Archive. This will only work for self extracting ZIP archives that conform to the ZIP specification.

4. How do I zoom an image in the viewer?
Zooming is performed either using the mouse by dragging a rectangle around the area you wish to zoom or using the zoom options in the Image menu (also available as a right mouse button pop up menu). You can also use the +/- key to zoom in/out.

5. Is it possible to change the sorting of files while in list view?
No, you can only change sort order in details view.
6. Is Magellan Explorer available in language X, Y or Z?
No, Magellan Explorer is only available in English at this time. If there is enough demand we will consider adding additional languages in a future release.

7. Does Magellan Explorer replace Windows Explorer?
No, Magellan Explorer works alongside Windows Explorer and you have the option of using whichever suits you best at the time. Magellan Explorer does, however, provide more or less all the functionality presented in Windows Explorer in addition to plenty of other features not found in Windows Explorer.

8. Can I synchronize sub folders?
Yes, the new Folder Synchronize tool in Magellan Explorer 3.0 supports this.

9. How do I disable the internal image viewer?
By default when you double click an image filetype supported by Magellan Explorer the image will be shown in the internal viewer. This feature can be disabled in the preferences if you would rather use the application associated with this filetype. To disable it open the "Misc" preferences and go to "Misc" and uncheck Open supported image filetypes in the viewer when doubleclicked.

10. I am using the right mouse button to select files, how do I display context menus?
With this selection mode you need to hold down the right mouse button for approximately one second before the context menu will be shown.

11. ADC Systems PicaView is not displaying thumbnails in my context menus?
Make sure 'Compatibility Mode' is turned on in PicaView's options. This will enable PicaView to work with the Magellan Explorer context menu.

12. Can Magellan Explorer remember the folder sort order?
Yes. Sort the folder the way you want it and select "Customize Folder" from the view menu. This also lets you save other folder specific settings. You can even save settings globally for all folders.

6.1.3 FTP support
Questions related to the built-in FTP support in Magellan Explorer is answered in this section. This FAQ is also available on our web site.

1. Remote FTP file modified time may not be correct
Magellan Explorer 3.0 will attempt to determine the time zone of the remote computer and compare this to the time zone of your computer when displaying file times for files on remote FTP servers. However, most FTP servers offer no way to determine the time zone and they will be assumed to be on UTC/GMT time, which may not be correct. This is ultimately a limitation in the FTP protocol and there is only so much we can do.

2. How can I delete the FTP sites address history from the FTP Connect dialog?
You can do this by deleting the following registry key using regedit:

HKEY_CURRENT_USER\Software\Enriva Development\MagellanExplorer3\Plugins\FTP\FTPConnectHistory
Make sure Magellan Explorer is not running when you perform this command.

3. Connecting to (some) FTP sites doesn't work
Magellan Explorer uses an FTP mode known as passive mode by default. This can cause problems with some FTP servers. You can change this to active from the preferences. Change the Connection Type setting in the FTP|Proxy section of the preferences.

4. How do I change file permissions?
Changing file permissions can be thought of as changing file attributes. Therefore, you can use the Attribute tool to accomplish this.

This feature requires server support for changing file attributes (through the SITE CHMOD command).

6.1.4 Miscellaneous
This sections answers questions that don't fit into any of the other sections. This FAQ is also available on our web site.

1. How do I turn my evaluation version into the full version?
Magellan Explorer 3 uses registration keys to unlock the full version. When you purchase a license you will receive this key which is uniquely matched with your name.

To unlock the full version you must first download and install the trial version, unless you have already done so. Then enter the license information either by clicking "Enter license code" on the trial dialog or selecting "Enter license code" from the Help menu.

Input your name as you specified it when you placed your order as well as they license code you received and click OK.

2. Are you going to port Magellan Explorer to any other operating systems?
There are no immediate plans.

3. Wasn't this application called Enriva Voyager before?
Yes, we have changed the name to Magellan Explorer.

6.2 Hints and tips
This section contain the same tips that are displayed by the Tip of the Day feature.

General tips

- We run a mailing list where you can subscribe to be notified of future releases. At times we also offer special discounts to members of this list. Click here to open the subscription form in your web browser.

- You can save the locations of your most often used folders in the favorites list just like in a web browser. Select 'Add Current Folder...' from the Favorites menu.
- Magellan Explorer automatically keeps track of which folders you have accessed recently by placing them in the history. Click the history tool on one of the tool bars to view the recent history.

- You can customize the method used for selecting files with the mouse. If you prefer the Windows Explorer style of non-sticky selection, or the right mouse button selection used in Norton Commander and its derivatives, you can easily change this within the user interface preferences.

- You can sort the contents of the folder window on e.g. name or extension by clicking on the corresponding column at the top of the folder window. Clicking again reverses the sort direction.

- Almost every tool within Magellan Explorer can be assigned a keyboard shortcut. Even favorites and user defined tools can have a shortcut assigned to them. You can configure what shortcuts should be used in the user interface preferences.

- You have 3 flexible tool bars at your disposal, each can be configured to contain the tools that suit you. Especially the quick bars (one above each folder window) can be very powerful. They apply directly to the folder window below, with no need to make it active first.

- Magellan Explorer can remember the column layout, sort direction and view for individual folders. Simply configure the folder the way you want it, then select 'Customize Folder...' from the View menu. The layout will now be remembered for the future."

- You can have Magellan Explorer start up in the exact same position and size every time by selecting 'Save window size and position' from the Options menu.

- Magellan Explorer can be configured to automatically start when Windows starts (or you log on). It can also be set to initially appear minimized in the system tray, ready for when you need it. These, and more, options are available in the User Interface preferences section.

- The help included with Magellan Explorer includes a 'frequently asked questions' (FAQ) section. Click here to open it. You can also find an expanded FAQ on our web site.

**Viewer tips**

- Magellan Explorer comes with a built-in image viewer capable of showing all popular image formats including GIF, JPEG, PNG and BMP. Simply right click an image file and select 'Magellan Explorer Viewer'. Or you can use the View tool.

- You can flip through the images in the current folder by first opening an image in the viewer followed by either the Page Up or Page Down key to change to the next image.

**FTP tips**

- Magellan Explorer comes with a built-in FTP client. Just open a connection from the FTP menu and you will be able to manage your remote files just as if they were on your local hard drive. Most of the available tools can also be used on FTP sites.

- Adding an FTP site to the site manager can be done by either opening the site manager and clicking new site, or if you're already connected to the site you can simply add it through the 'Current Session' sub menu in the FTP menu.

- When connected to an FTP site you can change options such as transfer type and filename case
conversion on-the-fly, either from the 'Current Session' menu on the FTP menu or by right clicking the label box above the folder window.

- The FTP information window (log window) has a context menu similar to the one you get by right clicking the label box. Among the options there is the ability to copy the contents to the clipboard.

**Archive tips**

- In addition to the ZIP format Magellan Explorer also supports the ACE, RAR, LHA, ARJ and CAB formats in addition to common UNIX formats such as TAR, GZip and BZip2.

- You can extract an archive into a separate folder by right clicking the archive and selecting 'Extract to <name of archive>...'. Or you can extract it to an existing folder by selecting 'Extract to...'.

- You can open a self extracting ZIP archive just as if it was a normal ZIP file by right clicking the archive and selecting 'Open Executable as ZIP Archive'.

- You can easily extract multiple archives at once by first selecting the files you wish to extract and then use the 'Extract' tool. The contents of the archives will be extracted into the destination folder window.

- Magellan Explorer can automatically compress the selected files when you create a new archive. Place a check mark next to 'Add the selected files and folders to the archive' in the new archive dialog.

- Installing a program directly from within an archive is possible by using the 'Install' feature available from the Archive menu. The contents of the archive is automatically extracted and the install program is launched. The extracted files are then deleted once the installation has completed.

- You can extract an archive by drag & drop. Simply drag the archive with the right mouse button to where you wish to extract it, and select one of the extraction choices from the menu that appears.

- Magellan Explorer handles multi volume ZIP, ACE and RAR archives completely transparently. Just double click the first file (with extension .zip, .ace or .rar) and Magellan Explorer will automatically locate the remaining files.

**Miscellaneous tips**

- The View menu contains some useful tools to change the file selection in the current folder window, namely 'Select All', 'Select None', 'Invert Selection' and 'Pattern Select'. The latter provide powerful wildcard (and regular expression) select and de-select capability.

- The 'Clone' tool lets you quickly create backup copies of existing files. Just select the files you wish to create copies of, invoke the tool and input the new names. The backup copies will be created in the same folder as the existing files.

- The 'Print Folder' tool let's you output the list of files in a folder (including size, date etc) to either a text file, the clipboard or even your printer. It can also traverse folders recursively, calculate MD5 checksums and folder sizes.

- The context menu displayed when you click on a file with the right mouse button is also available
from the File menu, just like in Windows Explorer.

- Clicking with the right mouse button on the label box (the area immediately above the folder window) will open a context sensitive menu with actions relating to the current folder, whether it be a file system folder, an archive or FTP site.

- You can quickly apply a filename pattern filter to the current folder. Just select the filter box (to the right of the path box) with the mouse (or pressing CTRL+ENTER) and type in the desired pattern. For example if you type 'image' then only files containing the word 'image' will be shown.

- You can generate the MD5 checksum (or fingerprint) of a file by right clicking it and selecting 'Copy MD5 sums to clipboard'. You can then compare the checksums of two files to easily check whether they're identical.

- Clicking with the right mouse button on the divider separating the two folder windows will reset it back to it's default center position.

- The small arrow button next to the path box below the folder windows enables you to load the folder displayed in one folder window into the other folder window. This feature can also be invoked by pressing CTRL+TAB on your keyboard.

- When using the default Magellan Explorer selection style without a keyboard cursor visible you can set focus to the path box simply by pressing ENTER on your keyboard. Similarly CTRL+ENTER sets focus to the filter box next to the path box. Just hit ENTER after typing a new folder path or filename pattern.

- You can assign multiple tools to each button on the main toolbar. Both the left and right mouse button can trigger different tools. You can also configure a drop down list of additional tools. Open the Tools & Toolbars preferences to customize your toolbars.

- Clicking with the right mouse button on a drive in the drive bar displays the context menu for that drive.

- We value our users' feedback! If you have suggestions for improvements or perhaps ideas of additional topics that could be included in the Tip of the Day feature please let us know. You can contact us by email at feedback@enriva.com.

### 6.3 Known issues

The following is a list of known issues in the release version.

**All: ADC Systems Pica View context menu thumbnail support**

To correctly display the Pica View thumbnails in context menus opened within Magellan Explorer you must check the Compatibility Mode option in Pica View's preferences.

**Windows XP: Changing background colors on toolbars in may not work**

Magellan Explorer 3.0 uses Windows XP theme functionality (if enabled) to draw the toolbars. This means that you cannot configure the background colors of the main toolbar, navigation bar, quick bar or drive bar in the preferences unless you use the Windows Classic theme.

**All: Remote FTP file modified time may not be correct**
Magellan Explorer 3.0 will attempt to determine the time zone of the remote computer and compare this to the time zone of your computer when displaying file times for files on remote FTP servers. However, most FTP servers offers no way to determine the time zone and they will be assumed to be on UTC/GMT time, which may not be correct. This is ultimately a limitation in the FTP protocol and there is only so much we can do.

**All: Importing 2.x config only imports first 3 custom tools**

The trial version of Magellan Explorer 3.0 is limited to 3 custom tools. Importing your existing 2.x configuration into 3.0 will therefore only import the first 3 tools. If you have a 3.0 license you can force a re-import of your 2.x configuration, assuming you did not delete it, after the license key has been entered by exiting Magellan Explorer and deleting your existing configuration in the registry using regedit.exe. Once you start Magellan Explorer you will be asked whether to import your 2.x configuration again. The configuration is located at the following location:

```
HKEY_CURRENT_USER\Software\Enriva Development\MagellanExplorer3
```

### 6.4 Customer support

In order for us to give you a quick and accurate solution it necessary that you supply us with some standard information about your system.

Please record the following information

- Magellan Explorer version number
- Windows version
- Basic hardware specification (RAM size, display adapter and CPU type and speed).

Send this information along with a detailed description of your problem to support@enriva.com and we will try to help you as soon as possible.

### 6.5 License agreement

Enriva Development DA

SOFTWARE LICENSE AGREEMENT

**IMPORTANT:** PLEASE READ THIS AGREEMENT CAREFULLY BEFORE CONTINUING WITH THE INSTALLATION PROCESS OF THIS SOFTWARE PACKAGE ("SOFTWARE"). BY CLICKING ON THE "YES" OR "ACCEPT" BUTTON YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, CLICK THE "NO" OR "DECLINE" BUTTON TO TERMINATE THE INSTALLATION PROCESS OR PROMPTLY RETURN THE UNOPENED PACKAGE AND THE REST OF THE PRODUCT TO YOUR SUPPLIER FOR A FULL REFUND IF YOU BOUGHT A LICENSE.

1. License. If you have purchased a license to the Software, Enriva Development DA ("Enriva") grants you a non-exclusive right and license to use the Software and the related documentation (the "Documentation") as set forth in this Agreement. You may use the Software on a single computer. You may also use the Software on a second (portable or home) computer so long as only one copy is used at a time. You may make a single copy of the Software for backup and archival purposes only provided that any copy must contain all proprietary notices included in the original. You may use the Documentation to assist in your use of the Software. You may review the Documentation, but you
may not make further copies of the Documentation. You own the media on which the Software is recorded, but not the Software itself or any copy of it. This license is not a sale of the original or any copy of the Software.

If you have obtained an evaluation copy of the Software, and have not purchased a license to the Software, Enriva grants you a 30-day non-exclusive license to use the Software, where a day is only counted if the Software is run ("used"), free of charge for the purpose of evaluating whether you wish to purchase an ongoing license for the Software.

WARNING: Evaluation copies of the Software will become non-functional after thirty (30) days, where a day is only counted if the Software is run ("used"), following initial installation on your computer. Enriva disclaims all liability and responsibility for any loss of data or other information which may occur as a result thereof.

You may distribute the evaluation version archive and make as many copies as you like provided that it is the official evaluation version archive. You are required to verify this.

You are specifically prohibited from charging, or requesting donations, for any such copies, however made and from distributing the software and/or documentation with other products (commercial or otherwise) without prior written permission.

2. Copying, Transferring or Modifying Software. The Software contains copyrighted material, trade secrets and other proprietary intellectual property. You may not permit concurrent use of the Software unless each user has an applicable license. You may not permit other individuals to use the Software except under the terms listed above. You may not decompile, disassemble, reverse-engineer or otherwise display the Software in human-readable form. You may not modify, translate, rent, lease, distribute or lend the Software, and you may not sell to others the right to use the Software on your computer. You may not remove any proprietary notices or labels on the Software. You may not copy, transfer, transmit, sublicense or assign this license or the Software except as expressly permitted in this Agreement. You agree that the terms of this paragraph apply to the Software or any portion thereof, owned by Enriva.

3. License to Use Content. All artwork, graphics, icons, media and other files contained in the Software, including without limitation are copyrighted material owned by Enriva or its licensors.

4. Term. If you have purchased a license to the Software, this Agreement and license are effective from the time you accept the terms of this Agreement until this Agreement is terminated. You may terminate this Agreement at any time by destroying all copies of the Software. This Agreement will terminate immediately and without further notice if you fail to comply with any provision of this Agreement. All obligations of confidentiality and restrictions on use, and all other provisions that may reasonably be interpreted to survive termination of this Agreement, will survive termination of this Agreement for any reason. Upon termination, you agree to destroy all copies of the Software.

If you have obtained an evaluation copy of the Software, and have not purchased a license to the Software, this Agreement and license are effective for a period of 30 days, where a day is only counted if the Software is run ("used"), from the date of installation of the Software.

5. Limited Warranty. If you have obtained an evaluation copy of the Software, and have not purchased a license to the Software, Enriva makes no warranties of any kind with respect to the media (if any) on which the Software is furnished, and such media is provided "as is" and without warranties of any kind.
6. Warranty Disclaimers. THE SOFTWARE, THE DOCUMENTATION AND (EXCEPT AS PROVIDED IN SECTION 5) THE MEDIA UPON WHICH THE SOFTWARE IS RECORDED (IF ANY) ARE PROVIDED "AS IS" AND WITHOUT WARRANTIES OF ANY KIND, EXPRESS, STATUTORY OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

The entire risk as to the quality and performance of the Software and the Documentation is with you. Should the Software or the Documentation prove defective, you (and not Enriva or its distributors, licensors or dealers) assume the entire cost of all necessary servicing or repair.

Enriva does not warrant that the functions contained in the Software will meet your requirements or operate in the combination that you may select for use, that the operation of the Software will be uninterrupted or error free, or that defects in the Software will be corrected. No oral or written statement by Enriva or by a representative of Enriva shall create a warranty or increase the scope of this warranty.

ENRIVA DOES NOT WARRANT THE SOFTWARE AGAINST INFRINGEMENT OR THE LIKE WITH RESPECT TO ANY COPYRIGHT, PATENT, TRADE SECRET, TRADEMARK OR OTHER PROPRIETARY RIGHT OF ANY THIRD PARTY AND DOES NOT WARRANT THAT THE SOFTWARE DOES NOT INCLUDE ANY VIRUS, SOFTWARE ROUTINE OR OTHER SOFTWARE DESIGNATED TO PERMIT UNAUTHORIZED ACCESS, TO DISABLE, ERASE OR OTHERWISE HARM SOFTWARE, HARDWARE OR DATA, OR TO PERFORM ANY OTHER SUCH ACTIONS.

Any warranties that by law survive the foregoing disclaimers shall terminate ninety (90) days from the date you received the Software as shown by your receipt.

7. Limitation of Liability. YOUR SOLE REMEDIES AND ENRIVA'S ENTIRE LIABILITY ARE SET FORTH ABOVE. IN NO EVENT WILL ENRIVA OR ITS DISTRIBUTORS OR DEALERS BE LIABLE FOR DIRECT, INDIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM THE USE OF THE SOFTWARE, THE INABILITY TO USE THE SOFTWARE, OR ANY DEFECT IN THE SOFTWARE, INCLUDING ANY LOST PROFITS, EVEN IF THEY HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

You agree that Enriva and its distributors and dealers will not be liable for defense or indemnity with respect to any claim against you by any third party arising from your possession or use of the Software or the Documentation.

In no event will Enriva's total liability to you for all damages, losses, and causes of action (whether in contract, tort, including negligence, or otherwise) exceed the amount you paid for this product.

8. High Risk Activities. The Software is not fault-tolerant and is not designed, manufactured or intended for use or resale as control equipment in hazardous environments requiring fail-safe performance, such as in the operation of nuclear facilities, aircraft navigation or communication systems, air traffic control, direct life support machines, or weapons systems, in which the failure of the Software could lead directly to death, personal injury, or severe physical or environmental damage. Enriva and its suppliers specifically disclaim any express or implied warranty of fitness for any high risk uses listed above.

9. Governing Law and Interpretation. This Agreement shall be interpreted under and governed by the laws of the Norway, without regard to its rules governing the conflict of laws. If any provision of this Agreement is held illegal or unenforceable by a court or tribunal of competent jurisdiction, the remaining provisions of this Agreement shall remain in effect and the invalid provision deemed
modified to the least degree necessary to remedy such invalidity.

10. Entire Agreement. This Agreement is the complete agreement between Enriva and you and supersedes all prior agreements, oral or written, with respect to the subject matter hereof.

If you have any questions concerning this Agreement, you may write to Enriva Development, P.O.Box 757, N-9258 Tromsø, Norway.

6.6 Our web site

We recommend that you stop by our web site if you are connected to the Internet. There you will find the latest version of Magellan Explorer as well as other related items.

The address is http://www.enriva.com/

6.7 Contact Information

You can use one of the following addresses to contact us:

Visiting address
Enriva Development DA
Trollringen 40A
N-9016 Tromsø
Norway

Postal address
Enriva Development DA
P.O. Box 0757
N-9258 Tromsø
Norway

Email info@enriva.com
Web http://www.enriva.com

We always welcome feedback on our products. Please drop us a line at feedback@enriva.com if you are connected to the internet.
Index

- A -
  Ace 109
  Acknowledgements 14
  Adding or modifying a keyboard shortcut 30
  Adding tools to the Button Panel 29
  Adding tools to the QuickBar 29
  Adding tools to the Tools menu 30
  Archive 44
  Archive managment 23
  Australia 118

- B -
  Belgium 119
  Bonus features 115
  Button Panel 48
  button panel tool bar 89

- C -
  Cash 116
  Colors and Fonts 81
  Command line options 34
  Confirmations 83
  Connecting to a FTP site 30
  Custom Tools 94
  Customer support 137

- D -
  Default keyboard shortcuts 34
  Defaults 80
  Denmark 120
  Display 82
  Drive Bar 93
  DriveBar 49

- F -
  FAQ 129
  favorites bookmarks 43

  Feedback 140
  Files 41
  Finland 120
  Folder advanced 104
  Folder Window 87
  France 121
  FTP 43
  FTP Advanced 106
  FTP Connect Disconnect 77
  FTP defaults 104
  FTP File transfers 105
  FTP Proxy 106

- G -
  General 86
  Germany 121

- H -
  Help 48
  Help on Help 6

- I -
  Internet auto update 100
  Italy 122

- K -
  Keyboard 82

- L -
  License agreement 137

- M -
  Money Orders / Checks 117

- N -
  Nav Bar 92
  navbar navigation bar 49
  Netherlands 122